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1.1 Apresentação 
 

A complexidade de certos programas, como é o AutoCAD, torna a tarefa de escrever manuais, 
roteiros ou apostilas que é nosso caso, um empreitada temerária, em todos os sentidos. Em 
primeiro lugar como decidir o nível de profundidade abordar, tanto na análise de estruturas e 
filosofias quanto nos comandos? 
Depois, como garantir abrangência necessária a  um texto que se destina, simultaneamente, aos 
profissionais das diversas engenharias, e tudo possa se relacionar com o desenho, se são distintas 
as "línguas" a que os profissionais de cada área falam? A resposta está numa constante 
preocupação com a objetividade, com a eliminação do supérfluo. Isso torna esta apostila (assim 
espero) uma utilidade inegável para os que dão os primeiros passos. 
 

1.2 Introdução 
 

O objetivo desta apostila é ensinar de forma simples, objetiva e didática, os recursos do 
AutoCAD 2004,  para projetar em duas dimensões e uma introdução ao ambiente 3D. 

 Os ensinamentos incluídos, abrangem a maioria das necessidades dos profissionais e das 
empresas, enfocando de forma especial as partes críticas do programa, mesmo com as recentes 
atualizações do programa, pouca coisa do básico desde o lançamento  AutoCad R14 teve mudanças 
significativas, podemos destacar a introdução da projeção com Polar, Otrack e as ferramentas do 
3D. 
  Sendo o AutoCAD um programa com grande número de comandos e opções, e , 
considerando sua interface pouco amigável, sugiro que prestem bastante atenção na explicações 
que com certeza muitos "macetes" e dicas farão diferença na produtividade e na qualidade de seus 
serviços. 

 
1.3 - Conceitos 

 CAD - A sigla CAD vem do inglês "Computer Aidded Design" que significa Desenho 
Assistido por Computador. Na verdade são programas (softwares) para computador específico para 
geração de desenhos e projetos . 
 CAE – “Computer Aidded Enginner” – Esse por seguinte é uma etapa que realiza em 
“protótipos”, exercer em desenhos virtuais as cargas e esforços cuja tal peça vai sofrer em seu o 
trabalho ou sua utilização. 

CAM - A sigla CAM também vem do inglês "Computer Aidded Manufacturing"  que significa 
Fabricação Assistida por Computador. Esse um passo posterior ao CAD, (na Mecânica) se 
caracteriza pela geração de códigos específicos interpretáveis por máquinas operatrizes utilizadas 
na fabricação de peças. 

Gis – (Geografic Information Sistem” Sistema de geoprocessamento – Sistema para 
processar e gerar imagens cartográficas, mapeamento e elaboração de bases cartográficas e 
bancos de dados. 
 AutoCAD - O AutoCAD é um programa (software), que se enquadra no conceito de 
tecnologia CAD é utilizado mundialmente para a criação de projetos em computador. Na verdade, 
AutoCAD é o nome de um produto, assim como Windows, Office (Word, Excel,...), etc. existem 
outros softwares de CAD como MicroStation, VectorWorks, IntelligentCad; para modelamento 
tridimensional  e paramétricos como Catia, Pro Engineer, Solid Works, Solid Edges, etc. 
  Aplicabilidade - Muitos dos programas CAD que existem no mercado aplicam-se a uma 
necessidade especifica, como arquitetura, mecânica, elétrica, geoprocessamento entre outras. 
Outros sistemas de CADD também se firmaram como padrão, como o Micro-Station e o 
VectorWorks. Sistemas de CAD (projeto e desenho), CAM (Manufatura), CAE 
(Engenharia), GIS (Geoprocessamento) específicos tem sido criados, destinados à 
mecânica, agrimensura, engenharia, arquitetura, topografia, estradas, modelagem, tais 
como o AutoCAD, AutoSurf, AutoArchitect, AutoBuilding, Cad Overlay, Catia, GisPlus, 
EMS e Hiteck. 
 Autodesk - Autodesk é o nome da empresa que desenvolve e comercializa o AutoCAD.
  

 
 
1.4 - Referências 
 

- AutoCAD 2004 - User's guide- Autodesk. 
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Introdução 
 
2.1 – A Tela Gráfica 
 
Barra de Propriedades      Menu Suspenso(Pull Down) 
                    Barra Standard 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Barras de ferramentas (Toolbar) 
                           Linha de comando(Prompt) 

                       Barra de Status 
 
2.2 - Personalização do AutoCAD 
 

Ativação de barras de ferramentas (Tollbars)- Clicar qualquer icone com o botão direito. Ativação do menus de 
controle ou (View→Toolbars) 

 
Ativação de personalização pessoal ( Tools → Options) ou direcione o mouse na tela gráfica e clique com botão 
direito. 
Toolbar – Barra de Ferramentas que você pode personalizar a qualquer momento que queira ao clicar o botão 
direito do mouse em qualquer ícone da sua tela. 

 

 
2.3 - Teclas de F1 a F11 no teclado com a BARRA DE STATUS 
 
Coordenadas(F6) F9 F7 F8 F10 F3 F11   

 

Tela Gráfica 
Área de trabalho 

PROMPT ( linha de comando) – Permanece normalmente na  parte inferior do programa permite a 
visualização da digitação dos comandos, como coordenadas e descrição dos comandos e as respostas 
aos comandos feitos pelo AutoCAD. Lembrando que para uma nova entrada de comando precisa estar 
“limpo” na frente da palavra command na maioria dos comandos.  
É importante prestar muita atenção nas mensagens exibidas na linha de command , pois é assim que 
o AutoCAD se comunica com você. Listando tudo que você realiza dentro do programa. 
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F1 Help 

F2 Carrega a tela de texto. 

F3/OSNAP Aciona o quadro Drafting Settings OSNAP (comandos de Ancoragem) e ON/OFF OSNAP 

F4 Aciona a mesa digitalizadora (se houver)(COMANDO TABLET) 

F5 Controla o ISOPLAN planos isométricos 

F6 Controlador das Coordenadas 

F7/GRID Ativa/Desativa o GRID  - Cria uma malha de pontos imaginários e  não imprimíveis na tela gráfica. 

F8/ORTHO Ativa/Desativa o ORTHO - Trava o cursor no eixo ortogonal, permitindo realizar linhas perfeitamente 

retas ou execução de comandos de edição mantendo-se no alinhamento. 

F9/SNAP Ativa/Desativa o SNAP  - Permite um deslocamento ajustável do cursor, dependendo ou não da 

marcação do Grid ligado ou desligado. 

F10/Polar Ativa/Desativa  Polar Tracking (exibe as posição corrente em coord. Polares) 

F11/OTRAC
K 

Ativa/Desativa  0snap tracking (exibe projeções em relação aos osnaps vigentes) 

LWT Ativa/Desativa o Line weight trace (exibe a espessura corrente pré determinada). 

MODE Controla o uso do modo model space e paper space 

 
2.3.1 - SETTINGS- (Tools Drafting Settings) / clicar Botão direito em cima de GRID, SNAP ou outro da barra de 
Status, acessando as caixas para configurações. 
 Estes comandos na barra de status será  de grande uso e todo o processo de construção de nossos projetos e 
desenhos.  
 
2.4 - COMANDO REGEN - Provoca uma regeneração do do desenho, isto é, regenerar significa recalcular todas as 
entidades matemáticas contidas no desenho.( acionado pelo teclado) 
 
2.5 - COMANDO LIMITS - Define os limites da área de trabalho. Seu uso é necessário, pois auxilia na regeneração 
da imagem. Quando acionamos o grid , o AutoCAD usa a área delimitada pelo comando  limits para posicionar o grid. 
 
3 - Teclas Importantes 
 

ESC Cancela o Comando Ativo - CANCEL 
ENTER Confirma a maioria dos Comandos e Ativa o último comando realizado. 

 
4 - Botões do Mouse 
 
O botão à esquerda é o botão de seleção do mouse ou um ponto de introdução. 
O botão do meio (se houver e se estiver configurado) do mouse +CTRL ativa os comandos de OSNAP – Se tiver o 
“Roller” serve rotacionando para ampliar ou diminuir o Zoom e pressionando o roller move a tela com o conado Pan. 
O botão direito em cima dos botões da barra de Status aciona a caixa de diálogo Dsettings 
O botão direito do mouse +CTRL ativa os comandos de OSNAP 
O botão à direita  aciona o menu flutuante - para corresponde ao < ENTER >, Undo, entre outras opções. 
 
5 - Unidades de Trabalho 
 
Sempre existe dúvidas, para começa a trabalhar com o Auto Cad, sobre, qual a unidade que se trabalha?  
Temos que considerar que, por exemplo, tivermos a distância entre dois pontos de 10 unidades, o AutoCAD interpreta 
esta unidade como adimensional ou seja, o que você Trabalha considerando a leitura real que você irá desenvolver seu 
projeto; se fizer uma linha de 10 unidades podem ser 10 mm, 10cm, 10m, 10Km, etc. Se começar um desenho 
trabalhando por exemplo que o passo de 1 seja 1m todo desenho você deve considerar como trabalhando em metros; 
0,5m, 1 m, 10 m e assim vai. Lembrando quem trabalha na mecânica trabalha com milímetros assim 50 mm equivalem 
a andar 50 unidades na tela do AutoCAD. Neste momento podem achar um pouco estranho, falar sobre tamanho real, 
mas guarde, que sempre será melhor criar seus desenhos adotando medidas reais que você mediu  ou adotou mediante 
uma unidade . Numa questão geral, é o  trabalho  maior será tivermos que imprimir ou plotar o desenho, mais isto 
veremos no final. 
 
6 - Símbolos Especiais 

Alguns símbolos/caracteres especiais podem ser introduzidos nas edições dos textos executados no AutoCAD 
através de combinações de teclas. As principais são descritas abaixo: 

%%C  obtém o símbolo de DIÂMETRO (φ); 
%%D  obtém o símbolo de GRAU ( º );  
%%P  obtém o símbolo de MAIS/MENOS ( ± ); 
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7 - Barra Standard 

 

7.1 – NEW (File > New) 
 Cria um novo desenho. No 2004, após aberto o primeiro – se a opção se Start Up (Configurações 
de Options  System – startup), não estiver acionado “Show StartUp dialog box” , ele pedira para 
abrir um arquivo template acad.dwt – também funciona, mas é melhor a caixa de dialogo 
tradicional. 

 

7.2 – OPEN (File > Open) 
Abre um desenho já existente. 
7.3 - SAVE (File > Save) 
Salva o “rascunho” (template) corrente. Se não foi dado um nome ao desenho, o AutoCAD lhe 
pedirá um nome. Lembrando que o AutoCad salva normalmente com a extensão .DWG e um 
arquivo .BAK que é arquivo de segurança, caso perda o seu desenho original ou aconteça algo que 
danifique seu arquivo, voce poce renomear o seu .BAK para .DWG e assim recuperar parte do seu 
desenho.  7.4 - SAVE AS(File > Save As) 
Tem a mesma função do comando Save, salvar um desenho. Com a diferença de lhe perguntar o 
nome do desenho antes de salva-lo. OBS. Esse comando é principalmente utilizado para preservar 
o desenho já existente e renomeiando com outro nome ou outro local. 

 

7.5 – UNDO  
Desfaz  o último comando, para alguns comandos serve para desfazer a seleção, para o comando 
line especificamente dentro de seu comando ativo desfaz o último segmento de reta 
sucessivamente. 

 

7.6 -  REDO 
 - Refaz apenas o último comando desfeito pelo comando “UNDO”. 

 

7.7 -  PLOT (File > Plot ) 
Plot (ou print ) Envia o desenho para que seja impresso em uma impressora gráfica ou  plotter 
(impressora de grande porte), A opção de impressão será detalhada mais adiante. 

 

7.8 -  PLOT  PREVIEW (File > Plot Preview) 
Mostra como o desenho será visto quando impresso ou plotado. 

 

7.9 -  PUBLISH (File > Publish ) 
Permite gerar arquivos em formato próprio para utilização em páginas de Internet. 

 
7.10- (CUTCLIP – COPYCLIP – PASTECLIP)  
Permite como no formato tradicional do Windows  Recortar – Copiar - Colar enviando para a 
área de transferência ou Recuperando. 

 
7.11- EXIT (File<Exit AutoCAD) 
DISCARD CHANGES – Abandona a tela gráfica e não grava as últimas alterações feitas no 
desenho. 
SAVE CHANGES – Grava o desenho no disco e abandona  a tela gráfica. 

8 - LINE  
 Acesso – Draw > Line  
Modo Simplificado:  L  (via Teclado) 

Formato:  
Command: LINE <ENTER>  
LINE Specify first point: P1 (Clique com botão esquerdo  um ponto na tela) 
Specify next point or [Undo]:P2 
 Specify next point or [Undo]: Para Confirmar a linha Tecle <ENTER> 
Funções Botão direito (Caixa Flutuante): 
ENTER: Confirma o desenho. 
CANCEL: Cancela o Comando 
CLOSE: -Fecha um polígono unindo o último ao primeiro segmento. ( C, via Teclado ou acionando a 
caixa flutuante com o botão direito do mouse e selecionando a opção) 
UNDO:- Desfaz o último segmento desenhado ( U, via Teclado ou acionando a caixa flutuante com o 
botão direito do mouse e selecionando a opção) 
PAN e ZOOM: Chama o comando PAN e ZOOM, para manipulação do desenho. 
CONTINUE: Para começar uma nova linha no último ponto dado, responda com um <ENTER> a 
pergunta  “from point.. 

9 - ERASE 
 Acesso – Draw > ERASE  
Modo Simplificado:  E  (via Teclado) 

Command: Erase 
Select objects: Use um  método de seleção de objeto <ENTER> 
OBS: Após a realização da seleção, é necessário teclar <ENTER> para que possa alterar para o próximo estágio do 
comando. 

Nota: A remoção de entidades no desenho são também realizadas através da tecla DEL, clicando em cima das 
entidades sem comando ficando acesso os “GRIPS” (normalmente quadradinhos azuis) e confirmando com o <ENTER>. 
 Pode-se tirar os “grips" clicando ESC duas vezes. Os Grips são ferramentas muito utéis, mas tarde veremos que 
podemos usar como forma de atalhos para muitos comandos do AutoCAD. 

 

P1 P2 
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10  - Critérios de Seleção 
Quando se executa um determinado comando, e precisamos  selecionar um  objeto podemos: 

 

Por Default o cursor troca para  forma de  um quadradinho (Pick Box), e a expressão 
‘Select Objects..’ é exibida na Barra de Comando. 
 Neste momento podemos selecionar entidades uma a uma os objetos a serem 
trabalhados. 

 

Windows - Captura entidades que estão contidas inteiramente  dentro de uma janela 
de seleção, que você clique fora do objeto e enquadrando- ( da esquerda para direita) 
 

 

Windows Crossing – Captura entidades que estão contidas dentro da janela ou 
que cruzarem a linha tracejada de uma janela. (da direita para a esquerda). 
 

 

Fence (f)- Captura  entidades por uma linha imaginária. 
Após o Select Object  - digite um “F”  
First fence point:P1 
Specify endpoint of line or [Undo]: P2 
Specify endpoint of line or [Undo]: P3 
Specify endpoint of line or [Undo]: P4 
Specify endpoint of line or [Undo]: <ENTER> Para confirmar seleção 

 

Cpolygon (cp) - Captura através de um polígono imaginário o que contiver dentro 
dele ou que cruzarem. 
Após o Select Object  - digite um “CP”  
First fence point:P1 
Specify endpoint of line or [Undo]: P2 
Specify endpoint of line or [Undo]: P3 
Specify endpoint of line or [Undo]: P4 
Specify endpoint of line or [Undo]: <ENTER> Para confirmar seleção 

 

Wpolygon (wp) - Captura através de um polígono imaginário o que contiver dentro 
dele. 
Após o Select Object  - digite um “WP”  
First fence point:P1 
Specify endpoint of line or [Undo]: P2 
Specify endpoint of line or [Undo]: P3 
Specify endpoint of line or [Undo]: P4 
Specify endpoint of line or [Undo]: <ENTER> Para confirmar seleção 

Outros:  All - Seleciona todas as entidades em tela gráfica. 
Last (L): Seleciona a última entidade desenhada, atualmente visível. 
Previous (P): Seleciona o último grupo de entidades selecionadas por um comando de edição. 
Remove: Permite remover entidades selecionadas do comando em ação ou Clique novamente a entidade selecionada 
por engano com a tecla Shift pressionada. 
ADD: Retorna ao modo de seleção normal após a utilização do Remove. 
 
11 - COORDENADAS 
Quando precisamos construir um desenho com dimensões exatas no AutoCAD, necessitamos orientar esta construção 
fornecendo dados de sentido e valores pelo mouse ou digitado através do teclado. 
É o que chamamos de entradas de coordenadas. Mesmo hoje com varias atualizações do AutoCAD, com algumas outras 
funções de facilitação de entradas de dados, o entendimento das coordenadas é crucial para o posicionamento e um 
bom desempenho na execução dos desenhos. Estas coordenadas podem ser absolutas ou relativas. 
 

IMPORTANTE:  

 - A virgula SÓ separa os pontos coordenados( X , Y)  – em qualquer 
situação dentro do AutoCAD e o  ponto separa números  “quebrados” 

(mantissa), (por uma condição americana) EX. 54.87 – 12.14 – 34.69 etc. 
- A orientação X sempre será na horizontal 
 –para direita valores positivos (+)  
- para esquerda valores negativos(-). 
 
 - A orientação  Y sempre será na vertical  
- para cima – valores positivos (+)  
- para baixo valores  negativos( -). 
Os pares ordenados sempre X e o primeiro termo e Y sempre é o 
segundo. (X,Y)  
 NOTA: A configuração sempre será pela orientação ao lado seguindo os quadradantes do plano cartesiano. 
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 11.1 - AS COORDENADAS ABSOLUTAS cartesianas trabalham como se fosse a introdução de coordenadas de pontos 
num gráfico, adicionando-se um ponto na tela ou teclando em pares coordenados X e Y, separados por vírgula.  
Essas coordenadas tem como base o zero absoluto (Canto inferior esquerdo da tela gráfica) do AutoCAD (interseção do 
eixo X com o eixo Y). 
Command : LINE  (Acionamos o comando line) 

From point: 0,0   <ENTER>  
To point: 40,0     <ENTER>  
To point:40,10    <ENTER>  
To point: 30,10   <ENTER> 
To point: 30,30   <ENTER> 
To point:20,50    <ENTER> 
To point:10,30    <ENTER> 
To point:10,10    <ENTER> 

            To point:0,10      <ENTER> 
To point:0,0       <ENTER> ou close 

            To point: <ENTER>finalizando 
 

 

11.2 - Coordenadas Relativas Cartesianas 
 

AS COORDENADAS RELATIVAS especificam uma distância em relação ao último ponto, podendo ser cartesianas ou 
polares. Para informações o 
AutoCAD  entenda a 
coordena a relativa, utiliza-
se o símbolo “@”antes do 
par coordenado. 
A coordenada relativa 
resolve nosso problema, 
quando desejamos criar 
uma linha com uma certa 
distância a partir de um 
ponto qualquer, temos que 
“dizer” para o AutoCAD que 
aquele  é o ponto 0,0; para 
isso e só indicar antes da coordenadas  o símbolo de @.  
1ºExemplo 

Command : LINE 
LINE Specify first point: P1 
Specify next point or [Undo]: 
P2  To point: @50,0             <ENTER>  
Specify next point or [Undo]:  
P3    To point:  @0,20           <ENTER> 
Specify next point or [Close/Undo]:  
P4    To point:  @-60,0          < ENTER > 
P5    To point:  @80,30         < ENTER > 
P6    To point:  @80,-30        < ENTER > 
P7    To point:  @-60,0          < ENTER > 
P8    To point:  @0,-20          < ENTER > 
P9     To point: @50,0           < ENTER > 
P10  To point:  @0,-15          < ENTER > 
P11  To point:  @-140,0        < ENTER > 
 
CLOSE (clique o botão direito do mouse e selecione 
a opção Close para fechar nosso objeto e finaliza-lo.  

 
 

LEMBRETE: Caso erre algum ponto, clique o botão direito 
do mouse e acione a opção UNDO para desfazer a última 
linha. 

  2ºExemplo 
Command : LINE 
LINE Specify first point: P1 
Specify next point or [Undo]: 
P2  To point: @50,0          <ENTER>  
P3    To point:  @15,20     <ENTER> 
Specify next point or [Close/Undo]:  
P4    To point:  @0,30       < ENTER > 
P5    To point:  @-5,0       < ENTER > 
P6    To point:  @-25,-30  < ENTER > 
P7    To point:  @-20,0     < ENTER > 
P8    To point:  @-25,30   < ENTER > 
P9     To point: @-5,0       < ENTER > 
P10  To point:  @0,-30     < ENTER > 
P11  To point:  @15,-20   < ENTER >< ENTER >
Nota: parafinalizar um desenho teclamos < ENTER >
se teclamos < ENTER > novamente acionamos o 
último comando e no caso específico de LINE se 
teclamos um < ENTER > pela 3º vez e volta ao 
último ponto feito. 
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11.3 - Coordenadas Polares 
A coordenada relativa polar necessita do comprimento L (distância) e a abertura angulo medido entre o eixo 0(zero) e a 
linha na qual pretende realizar. 

 
Command: L 
LINE Specify first point: P1 
P2 -Specify next point or [Undo]: @20<315 
P3 -Specify next point or [Undo]: @25<0 
P4 -Specify next point or [Close/Undo]: @10<300 
P5 -Specify next point or [Close/Undo]: @10<240 
P6 -Specify next point or [Close/Undo]: @25<180 
P7 -Specify next point or [Close/Undo]: @20<225 
P8 -Specify next point or [Close/Undo]: @20<90 
P9 - Specify next point or [Close/Undo]: @4<0 
P10 -Specify next point or [Close/Undo]: @5.6<90 
P11 -Specify next point or [Close/Undo]: @4<180 
P12 -Specify next point or [Close/Undo]: close  
Command: L  
LINE Specify first point:P1 
P2 -Specify next point or [Undo]: @20<0 
P3 -Specify next point or [Undo]: @5<30 
P4 -Specify next point or [Close/Undo]: @25<90 
P5 -Specify next point or [Close/Undo]: @15<120 
P6 -Specify next point or [Close/Undo]: @5<90 
P7 -Specify next point or [Close/Undo]: @6.5<0 
P8 -Specify next point or [Close/Undo]: @2.5<90 
P9 - Specify next point or [Close/Undo]: @6.5<180 
P10 -Specify next point or [Close/Undo]: @8.8<60 
P11 -Specify next point or [Close/Undo]: @22.46<180 
P12 -Specify next point or [Close/Undo]: @8.8<300 
P13 -Specify next point or [Close/Undo]: @6.5<180 
P14 -Specify next point or [Close/Undo]: @2.5<270 
P15 -Specify next point or [Close/Undo]: @6.5<0 
P16 -Specify next point or [Close/Undo]: @5<270 
P17 -Specify next point or [Close/Undo]: @15<240 
P18 -Specify next point or [Close/Undo]: @25<270 
P19 -Specify next point or [Close/Undo]: @5<330 
Specify next point or [Close/Undo]:<ENTER> 
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11.4 - Coordenadas Automáticas ortogonais 
 

Este comando é usando empurrando o  mouse para o lado que se quer construir a linha vertical ou 
horizontal, sendo que o ORTHO deve estar acionado.( teclando em F8 ou clicando duas vezes no botão 
ORTHO na barra de status. Quanto às diagonais devem ser dadas coordenadas relativas ou polares. 
Lembrando também que a execução das diagonais devem ser digitadas normalmente ou atraves das 
coordenadas relativas ou polares dependendo dos dados que tenha. 
 
Command : LINE 
From point: P1 (Ponto 
Qualquer)< ENTER>  
To point: 30  →  <ENTER >  

To point:10↑     < ENTER >  

To point: 10  ←   < ENTER >  

To point: 20 ↑       < ENTER >  
To point:@-10,20  <ENTER >  
To point:@-10,-20  <ENTER > 
To point: 20  ↓        < ENTER > 

To point:  10 ←      < ENTER > 
To point: 10  ↓      < ENTER > 
To point:  <ENTER>finalizando 
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11.5 - Coordenadas Automáticas Polares 
Quando você move seu cursor, caminhos de alinhamento e Tooltips são exibidos quando você move o cursor perto 
ângulos polares. O Default busca medição está 90 graus, pode adicionar outros ângulos usando a caixa de diálogo Use o 
caminho de alinhamento (linha pontilhada) e Tooltip (indicação do ângulo referente) para desenhar a sua linha  
inserindo uma medida no teclado. 
Podemos também pode usar Osnap Polar com Interseção  o encontro traçado pelo caminho de alinhamento polar entre 
projeção de outra linha. Podemos ver mais claramente esse comando, na construção dos blocos isométricos que se 
segue abaixo  na qual descreve como isso funciona. 
 
11.6 - TUTORIAL COORDENADAS AUTOMÁTICAS 
POLARES e uso Projeções Isométricas : 
Com   a introdução das coordenadas automaticas polares, se torna muito fácil 
criar peças isométricas,  para isso temos que configurar a caixa settings  
conforme ao lado: 

1) Clique o botão direito do mouse em cima da palavra POLAR na barra 
de Status. 

2) Em Increment angle – Clique na “setinha” caixa  selecione o 
ângulo de 30º. 

3) Mantenha como esta ao lado a seleção Track all polar angle para que 
todos ângulos complementares de 30º sejam mostrados em sua 
projeção. 

4) Mantenha também  a opção Abolute para a partir de cada ponto 
mostre o ângulo absoluto. 

 

 

 

 
 
OBS: Note que a execução se tornou muito fácil, mas no caso da nossa estrela os todos ângulos são complementares de 
30º - Se houvesse outros ângulos ou ângulos quebrados era mais fácil adicionar por coordenadas polares do que ir na 
caixa drafting settings e confirar o ângulo presumindo os seus complementares.  
O Conhecimento das coordenadas polares é imprensidivel, como também a interpretação do desenho, um pouco de 
trigometria são necessários para uma rapidez de execução do nosso projeto. 
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- Projeções Isométricas 
A partir dessa  mesma configuração anterior  podemos traçar uma peça isométrica, lembrando que uma peça isométrica 
– você trabalhará com ângulo de 30º e seus ângulos complementares sempre com linhas paralelas. 
Nota: Confira os botões da Barra de Status devem  estar ligados POLAR, OSNAP( com as opção de ENdpoint 

ligada)OTRACK. 

 
 
 

 

      

 

38
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21 - ELLIPSE 

 Acesso – DRAW> Ellipse 
Modo Simplificado:  EL (via Teclado) 

Acionado  o comando ELLIPSE  - O AutoCad como default necessita da indicação da distancia do 
raio do eixo horizontal  e na seqüência a altura para a sua definição. 
Nota: Lembramos que para a criação de um circulo no plano isométrico, temos que criar uma 
elipse. Para traçar uma elipse isométrica, a opção “ligada” somente após o plano da tela gráfica 
fique configurado para isométrica.   
Botão Direito sobre SNAP ou Grid – Settings –Caixa Selecione a  opção “Isometric Snap”. Já  
configurado  dessa forma o cursor se transforma em um formato isometrico, a partir daí  podendo 
trocar os planos ISOPLANE TOP, ISOPLANE LEFT, ISOPLANE RIGHT clicando o F5 do teclado.  
Agora acionando o comando Ellipse podemos perceber que existe uma nova opção que é o 
ISOCICLE. 

1- Por pontos externos 
Command:Ellipse (EL) 
Specify axis enpoint of endpoint of ellipse or 
(Arc/Center):P1 
Specify other endpoint of axis:P2 
Specify distance other endpoint of axis:P3 

 
2- Pelo Centro 
Command:Ellipse (EL) 
Specify axis enpoint of endpoint of ellipse or 
(Arc/Center):C 
Specify center of ellipse:P1 
Specify distance other of axis or (Rotation):P3  
3- Pela Projeção 
Command:Ellipse (EL) 
Specify axis  endpoint of ellipse or (Arc/Center):C 
Specify center of ellipse:P1 
Specify  endpoint of axis:25(ortho on) 
Specify distance other of axis or (Rotation):R 
Specify rotation around major axis: 60  
4- Criando um arco eliptico  
Command:Ellipse (EL) 
Specify axis of endpoint of ellipse or (Arc/Center):A 
Specify axis endpoint of elliptical or( Center):C 
Specify center of elliptical arc :P1 
Specify  endpoint of axis:P2 
Specify distance other of axis or (Rotation):P3 
Specify angle or (parameter):30 
Specify angle or (parameter/included):240 

 

 
Nota: Parameter- Determina a extensão do arco da elipse, com projeção em x. 
         Included- O usuário determina um angulo de varredura (angulo incluído no arco) 

 
Trabalhando com peças Isométricas cilíndricas 
 

 
1 – Para Configurar – Clique o botão direito do mouse sobre Snap 
ou Grid – Settings – Caixa Flutuante Draffting Settings – Acione a 
opção Isometric Snap. 
 
Obs: Note agora que o cursor esta isométrico. 
Acioando o comando Ellipse note que agora temos a opção 
ISOCIRCLE. 
Crie um cubo 30 x 30. 

2– Acionamos o comando Ellipse. 
Command:ELLIPSE 
Specify axis endpoint of ellipse or [Arc/Center/Isocircle]:  
(clique o botão direito do mouse e selecione 
a opção Isocircle) 
Specify center of isocircle: (Passe o mouse em P1 e P2 
ate cruzar as ortogonais a 30º e 270º clique para definir 
o centro da ellipse ) 
Specify radius of isocircle or [Diameter]: 15<enter> 
(como nosso cubo e 30 x 30 o raio será 15) 
 
3- Acionamos o comando Ellipse novamente – 
com centro em P3 – crie um Isocircle de raio 8. 
 
4 - Acionamos o comando Ellipse novamente – 
(Passe o mouse em P4 – empurre o no ângulo de 
330º digite 25 e  crie outro  Isocircle de raio 8). 
 
5 – Acione o comando LINE crie uma linha  de P5 
a P6 e depois P7 a P8 – use os pontos 
quadrantes da nossa ellipse. 
 
6- Acionamos o comando TRIM – Selecionamos 
as linhas clicando P9 e P10 - <enter>(definimos 
os limites para cortar) agora clique de P11 a P14 
para eliminar as linhas internas. 
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12 - RECTANGLE 

 Acesso – DRAW > Rectangle 
Modo Simplificado:  REC  (via Teclado) 

Define um retângulo. É definido por dois cantos, formado pela 
sua diagonal. 
Acionando o Comando RECTANGLE: 
1 – Inicialmente o comando pede um ponto, que pode ser 
aleatório ou um ponto determinado. 
2 – A partir desse ponto podemos gerar um retângulo por uma 
diagonal imaginária, onde podemos clicar um ponto para gerar 
um retângulo aleatório ou inserir uma coordenada relativa 
(@X,Y) respectivamente a sua largura em X e a sua altura em Y.  
 
Formato: 
Command: Rectangle (REC) 
Specify first corner point or (Chamfer,Elevetion, Fillet,Thikeness,Width:  P1 (Ponto qualquer) 
Specify other corner point or [Dimensions*]: Especifique o outro “canto” EX. @40,20 
 
Funções Botão direito (Caixa Flutuante): 
CHAMFER –Opção de chanfrar todos os canto do retângulo com medidas definidas 
ELEVATION- Opção p/  3D de criação de retângulo elevado a uma medida ao plano 0(zero) . 
FILLET- opção de arredondar todos os cantos definido por um raio. 
THIKENESS- Opção p/ 3D Específica uma “extrusão” das paredes do retângulo. 
WIDTH- opção de definir espessuras de linhas de seu retângulo. 
PAN e ZOOM: Chama o comando PAN e ZOOM, para manipulação do desenho. 
Opção* [Dimension] : 
Está opção você pode criar um retângulo sem a necessidade de coordenadas, 
 inserindo as dimensões laterais e indicando com o mouse o lado que se quer fixa-lo. 

 13 - CIRCLE 
 Acesso – DRAW > Circle 
Modo Simplificado:  C  (via Teclado) 

Acionando o Comando CIRCLE: 
1 – Inicialmente acionado o  comando pede-se  um ponto que é o centro do circulo, que pode ser aleatório ou um centro 
determinado. (Se caso querer criar um circulo por uma outra opção abaixo, acione a caixa 
flutuante e selecione a opção). 
2 – Agora é somente digitar o valor do nosso raio do nosso circulo.  
 
Funções Botão direito (Caixa Flutuante): 
3P – Desenha círculo através de 3 pontos 
2P – Desenha círculo através de 2 pontos 
TTR – Desenha círculo tangente a dois objetos selecionados e a especificação do raio. 
R- Desenha um círculo através de seu raio. 
D – Desenha um círculo, através de seu diâmetro. 
PAN e ZOOM: Chama o comando PAN e ZOOM, para manipulação do desenho. 

 
Formato pelo Raio : 
Command:Circle (R) 
CIRCLE Specify center point for circle or(3P/2P/Ttr): P1 
Specify RADIUS for circle or (diameter)>: 20 
NOTA:Acionado o comando CIRCLE - a partir de um ponto clicado (P1) ele 
sempre pedirá inicialmente o  valor do RAIO. 

 
Formato pelo Diametro: 
Command:Circle ( D) 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: P1 
Specify radius of circle or [Diameter]: D 
 Specify diameter of circle: 40 
NOTA:Acionado o comando CIRCLE – Clicamos o botão direito do mouse e 
acionamos o Comando DIAMETER. 

 
Formato por 2P e 3P: 
Command:Circle ( 2P) 
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2P 
Specify first end point of circle's diameter:: P1 
Specify second end point of circle's diameter: P2 
NOTA:Acionado o comando CIRCLE – Clicamos o botão direito do mouse e 
acionamos a opção 2P, para criar um circulo por 2 pontos. 
 
OBS:O mesmo temos com a opção 3P, criamos um circulo por 3 pontos 
clicados. 
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Formato por TTR: 
Command:Circle ( TTR ) 
Specify point on object for first tangent of circle: P1 
Specify point on object for second tangent of circle: P2 
Specify radius of circle : 30 
 
NOTA:Acionado o comando CIRCLE- Acionamos o botão direito, 
selecionamos a opção TTr – Tangente, Tangente e inserção do valor para 
um raio de concordância.   

 18 - POLYGON 
 Acesso – DRAW> Polygon 
Modo Simplificado:  pol  (via Teclado) 

A partir do acionamento do Comando POLYGON: 
1 –Inicialmente entrar com o número de lados do nosso polígono, como “default” ele oferece o número [4] quatro lados, 
defina quantos lados deseja e clique <ENTER> 
2 – Escolhido o nº de lados, ele pedirá um ponto que será por default o centro do poligono, difina o ponto e clique 
<ENTER> para continuar o comando. 
3 – Na sequencia ele pedirá para executar o poligono através da opção Inscribed <I> confirme com <ENTER>, ou acione 
a caixa flutuante e selecione a opção Circumscribed <C>. 
4 – Para finalizar ele pedirá um valor que se refere há raio imaginário com referencia a sua opção anterior. 

 
CIRCUMSCRIBED – Desenha o polígono definindo seu centro e raio, o polígono é desenhado 

tangenciando externamente a circunferência imaginária. 
 

INSCRIBED – Desenha o polígono definindo seu centro e um raio, o polígono é desenhado 
tangenciando internamente a circunferência imaginária 
 
EDGE – Desenha polígono a partir de uma lado. 
 

Command: 
POLYGON Enter number of sides <4>: (número 
de lados)3 
Specify center of polygon or [Edge]: 
Enter an option [Inscribed in 
circle/Circumscribed about circle] <I>: I 
Specify radius of circle: (raio imaginário)20 

 
Command: 
POLYGON Enter number of sides <4>: (número 
de lados)3 
Specify center of polygon or [Edge]: 
Enter an option [Inscribed in 
circle/Circumscribed about circle] <I>: C 
Specify radius of circle: (número de lados)20 

 
Command: 
POLYGON Enter number of sides <6>:6 
Specify center of polygon or [Edge]: E 
Specify first endpoint of edge: Specify second 
endpoint of edge: 20 

 
 

 14 - FILLET 
 Acesso – MODIFY > Fillet 
Modo Simplificado:  F  (via Teclado) 

A partir do acinamento do Comand o FILLET: 
1 – Inicalmente é necessário entrar com o valor do RAIO que desejamos arredondar o vértice, para isso acionamos a 
caixa flutuante (botão direito do mouse) e selecionamos a opção RADIUS e assim definir o valor do Raio  e Clicar 
<ENTER>  para a sua seqüência. 
2- Agora é somente clicar um lado do vértice e seqüencialmente clicar no outro lado do vértice. 
Opções do Comando: 
TRIM – Mantém ou não os cantos vivos originais, conforme o usuário opte por “TRIM” (opção Default) ou “No Trim”. 
POLYLINE – A partir de seu objeto ser uma polyline – especificando a opção todos os cantos são arredondados. 
 
Command: Current settings: Mode = TRIM, Radius = 0.0000 
Select first object or [Polyline/Radius/Trim]: <Opção Radius> <ENTER> 
Enter fillet radius <0.000>: Definimos o valor do raio 5  <ENTER> 
Polyline/Radius/Trim/<select first object>:P1  
Select second object:P2<ENTER> 
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15 - CHAMFER 

 Acesso – MODIFY > Chamfer 
Modo Simplificado:  cha  (via Teclado) 

A partir do acionamento do Comand o CHAMFER: 
1 – Bem parecido com a seqüência do Fillet - Inicialmente é necessário entrar com o valor das distancias que desejamos 
chanfrar vértice, para isso acionamos a caixa flutuante e selecionamos a opção DISTANCE e assim definir o valor das  
Distancia  e Clicar <ENTER> , se caso voce tenha uma distancia e um ângulo, acione a Opção ANGLE – defina primeiro o 
comprimento e o ângulo referente, para a sua seqüência. 
2- Agora é somente clicar um lado do vértice respectivamente o 1º clique pela definição da 1º distancia e 2º clique para 
a 2º distancia, isto serve para lados diferentes, para casos de lados iguais, que é o mais comum não importa o 1º 
clique. 
 

Command: CHAMFER 
(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 
Select first line or [Polyline/Distance/Angle/Trim/Method]: D <ENTER> 
: Enter first chamfer distance:Definimos 5 <ENTER> 
Enter second chamfer distance: Definimos o outro lado igual 5 <ENTER> 
Polyline/Distance/Angle/Trim/Method/<select first line:P1  
Select second line:P2  
Opções do Comando: 
METHOD – Especifica se o comando exibirá duas distancias de Chanfro ou uma distancia e um angulo. 
ANGLE – Permite ao usuário configurar o chanfro especificando angulo e o comprimento da linha de chanfro. 
DISTANCE – O usuário especifica as distancias correspondentes à projeção da linha de chanfro em X e Y. 
TRIM – Mantém ou não os cantos vivos originais, conforme o usuário opte por  “Trim” ou “No Trim”. 
Observação: Nas polylines o  Arredondamento e o Chanfro são feitos automaticamente em todos os cantos, exceto 
canto que eventualmente não estiver fechado. 

 

 
16 - TRIM 

 Acesso – MODIFY > Trim 
Modo Simplificado:  TR  (via Teclado) 

O TRIM uma das ferramentas muito utilizada no AutoCAD e onde recortamos e aparamos os  objetos.  
A partir do acionamento do Comando TRIM: 
1 –Inicialmente é Pedido para Selecionarmos o objeto a ser usado como linha de corte ou limite, que deverá 
obrigatoriamente ter uma  intersecção  ou estar cruzando o que irá ser cortado, clicamos <ENTER> a continuar. 
2 – A partir da escolha de nossa linha de corte, selecionamos o que  queremos recortar. <ENTER> para finalizar. 
Command: TRIM 
Current settings: Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects: P1 e P2<ENTER> 
Select objects: 2 found 
Select object to trim or shift-select to extend or [Project/ Edge/ 
Undo]: : (Selecione objetos a serem cortados). P1 e 
P2<ENTER> 
Select object to trim or shift-select to extend or [Project/Edge/ 
Undo]:  para finalizar <ENTER> 
Opções do Comando: 
PROJECT – O usuário escolhe o plano de projeção para o corte da 
entidade, no caso de trabalho em 3D. 
EDGE – Determina se a entidade será cortada ou não , no casode 
corte com base em um prolongamento imaginário de outra 
entidade. 
UNDO – Desfaz os cortes feitos, individualmente e remissavam/  

 
NOTA: A opção (shift-select to extend or) podemos 
alterar a situação de TRIM para o Comando EXTEND 
presionando a tecla Shift ao selecionar o objeto. 

 
EXTEND  Acesso – MODIFY > Extend 

Teclado:  EX   (atalho) 
A partir do acionamento do Comando EXTEND: 
Inicialmente é Pedido para Selecionarmos o objeto a ser usado como linha limite ou  de referência 
(linha ou objeto até onde queremos estender), clicamos <ENTER> a continuar. 
Escolhendo nossa referencia, selecionamos clicamos nos objetos que  queremos estender até está 
referencia, <ENTER> para finalizar.  
Opções do Comando: 
FENCE – Oferece a opção de um corte por linha imaginária. 
CROSSING – Oferece a opção de seleção por uma janela crossing. 
PROJECT – O usuário escolhe o plano de projeção para o corte da entidade, no caso de trabalho em 
3D. 
EDGE – Determina se a entidade será cortada ou não , no caso de corte com base em um 
prolongamento imaginário de outra entidade. 
UNDO – Desfaz os cortes feitos, individualmente e remissavamente. 
NOTA: Tabém temos a opção (shift-select to extend or) podemos alterar a situação de EXTEND para 
o Comando TRIM pressionando a tecla Shift ao selecionar o objeto. 
Dica: A casos para execução rápida acionado o comando e cliclamos um <ENTER> que selecionará 
todo o desenho, agora só clicamos o que vamos estender. 
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Command: EXTEND 
Current settings: Projection=UCS, Edge=Extend 
Select boundary edges ... 
Select objects or <select all>:(Selecione os objetos limite) P1 
<ENTER>  
 
Select objects: 1 found<ENTER> 
 
Select object to extend or shift-select to trim or 
[Fence/Crossing/Project/Edge/Undo]: 
Select object to extend or shift-select to trim or 
[Fence/Crossing/Project/Edge/Undo]: P2, P3, P4, P5, P6, P7 
<ENTER> (Selecionamos objetos a estender). 
  
Nesse caso poderíamos acionar a opção Fence e com uma linha imaginária com dois pontos - selecionar todas as linhas 
em vez de selecionar uma a uma como a operação acima. 

 

 
20 - HATCH 

 Acesso – DRAW > Hatch 
Modo Simplificado:  H  (via Teclado) 

O Comando Hatch é dos comandos mais utilizados na Mecânica, pois a hachura determina uma área de corte do 
material. Existem vários tipos de hachuras dependo do material utilizado na nossa peça que está sendo desenhada. O 
AutoCad apresenta uma infinidade de opções de hachuras, mas na mecânica a mais utilizada é o que esta contida na 
pasta ANSI.  
A partir do acionamento do Comando HATCH: 
1 –Inicialmente Clique dentro da janela “Swatch”  e selecione a pasta ANSI e clicamos em uma das opções ANSI 31 
(hachura de ferro) ANSI32 (hachura de aço) ANSI 33 (hachura para latão, bronze ou metal leve) ANSI 36 (Alumínio) , 
há outras mas dentro da mecânica e os mais usados, podemos relacionar devidamente conforme as nossas normas da 
ABNT. 
2-  Clicamos o botão “Pick Point”, para definirmos nossa área irá ser hachurada   (normalmente a área fica tracejada), 
obrigatoriamente nossa área deverá estar totalmente fechada, se tiver um  milésimo aberto ou mesmo a sua tela gráfica  
não enquadrar a sua area afim, o AutoCad emitirá uma mensagem de erro ao lado. 

 

3– Selecionada area que irá ser hachura clicamos <ENTER> para voltar;  podemos visualizar 
como fica nossa area hachurada, clicamos o Botão  “Preview”, para retornar na tela anterior , 
teclamos ESC para voltar, se clicarmos <ENTER> confirmará a hachura concluindo o comando. 
 

4- O valor  “Scale” refere a  distancia  entre as linhas de  hachura, podemos aumentar o valor para maior 
distanciamento  ou diminuir para ficar mais compacta. 
5- O valor do “Angle” refere ao ângulo de inclinação da hachura, por Default é 0 (zero) inclinado para direita e com 
ângulo à 45º , se caso queria inverter o lado da inclinação troque o “0” por 90. 
OBS:No AutoCad 2004 foi inserido tipos de hachuras com gradientes (Tela 3 Abaixo), muito usado para arquitetura, 
como por exemplo para um efeito de reflexão de uma  vidraça. 

1 2  
Opções do Comando: 
Pattern - determina o padrão de hachura a ser utilizado. 
Pattern Properties – define parâmetros de aplicação da hachura escolhida 
Iso Pen Width – especifica uma escala padrão ISO com base na caneta selecionada, somente para hachuras deste padrão. 
Scale – permite a correção da escala do padrão de hachura. 
Angle – controla o ângulo de aplicação da hachura em relação ao eixo X da UCS atual. 
Spacing – controla o espaçamento das linhas paralelas que compõem a hachura, disponível se  USER DEFINED estiver 
selecionada no quadro PATTERN TYPE. 
Double –quando assinalado o hachuramento é duplo e cruzado, disponível se USER DEFINED estiver selecionada no quadro 
PATTERN TYPE. 
Boundary – delimitação da superfície a ser hachurada. 
Pick Points – delimita a área a ser hachurada. 
Select Objects – a área a ser hachurada é determinada por seleção convencional de entidades. 
Remove Islands – permite a remoção de um conjunto de limites determinados como ilhas, quando utilizada a opção Pick 
Point. 
Preview Hatch – permite a visualização da hachura antes da sua execução 
Inherit Properties – recupera as características de uma hachura existente no desenho. É muito útil quando revisamos um 
desenho e não sabemos as características da hachura feita. 
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Associative e Noassociative – Definida uma area de uma peça feita com polylines podemos associar ou não associar a 
deformação dessa area com a hachura, isto é distorcer a peça com os “Grips” a hachura associativa acompanhará a 
deformação e a associativa se manterá inalterada. 

 

 22 - OSNAP   

Utilizado para encontrar pontos determinados das entidades.  
As funções de OSNAP são ativadas para encontrar um ponto desejado. Sua principal aplicação é proporcionar precisão 
ao traçado de entidades.  

Podemos manter ativos aqueles Osnaps’ que mais necessita através da caixa de dialogo clicando com o botão 
direito em cima da palavra OSNAP,na barra de Status, opção Settings. 
Quando se clica  na barra de Status Osnap ou o  F3, caso não haja nenhuma seleção já pré-setada, o AutoCAD 
automaticamente abre a caixa de diálogo Osnap Settings, vista anteriormente. Para um melhor  desempenho das 
funções evite deixar todos ligados, pois muitas vezes podem capturar pontos não desejáveis, se caso desejar precisar 
capturar um ponto e ele acende outro, podemos “forçar” a entrada clicando o seu ícone ou mesmo digitando as letras 
inicais em negrito abaixo. 

 
Modos:  

 
1. - TTemporary Tracy point – Localiza um ponto a partir de um ou uma série de pontos  

temporários. 
2. - FROM -  Estabelece um ponto temporário para que a partir dele e usando uma referencia 

ou coordenadas, pode-se determinar o ponto desejado. 
3. - ENDpoint – Ponto final de linhas, arcos e polylines 
4. - MIDpoint -  Ponto médio de linhas, arcos e polylines  
5. - INTersetion –Intersecção de dois objetos como segmentos de reta, círculos, arcos e 

splines. 
6. - APParent Intersection-  Atrai um ponto que faz intersecção aparente entre dois objetos. 
7. - EXTension  - Extente um ponto sobre a extensão de objetos 
8. - CENter – Centro de círculos e Arcos  
9. - QUAdrant – Define os pontos dos polos  de círculos e arcos( os pontos 0º,90º,180º e 

270º graus) mais próximos. 
10. - TANgent – Tangente a círculos e arcos a partir do último ponto definido  
11. - PERpendicular – Atrai para o ponto de um objeto que um alinhamento normal ou 

perpendicular com o outro objeto  
12. - PARallel- Desenha linhas paralelas a outras linhas existentes, só funciona com a 

projeções das linhas pontilhadas Polar ligada. 
13. -INSert - Atrai para um ponto de inserção de um bloco, texto, atributo (que contém 

informações de um bloco). 
14. -NODe - Atrai para um ponto desenhado com o comando point. 
15. -NEArest - Atrai para um ponto do objeto que esteja mais próximo ao ponto especificado. 
16. -NONe - Cancela todas as opções de snap ativas: end, mid, int,cen,etc. 
17. -OSNAP SETTINGS - Ativa a caixa de dialogo do comando OSNAP. 
      POINT FILTERS- Faz referências a um ponto e filtra suas coordenadas X,Y e Z. 
 
DICA:interessante é utilizar a tecla “TAB” do teclado para alternar entre os object snap ligados 

 

 

Nota:  É constante a necessidade de usar modos para "CAPTURAR" os pontos na construção de desenhos. Para acioná-
los apenas uma vez, clique no botão direito+SHIFT na tela gráfica com um comando ativo aparecerá este menu rápido  
com os modos de "capturar" os pontos necessários. 
 

RETOMANDO TRABALHAR COM AS  COORDENADAS POLARES AUTOMÁTICAS 
 

TUTORIAL 
Abaixo Construiremos Passo-a-Passo o  Segundo 

desenho ao lado , mostrando o uso  das coordenadas 
polares automáticas – 

Comandos que serão usados : 
LINE, CIRCLE, FILLET, LINETYPE, HATCH  

 

  1    2     3    4     5     6    7     8    9    10   11   12   13  14   15   16    17 
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1- Construindo um objeto com comando LINE utilizando o Snap,Polar,Otrack : 
Command:  LINE 
 Specify first point: P1(Clique um ponto qualquer)  
Specify next point or [Undo]:  <Polar on> (empurre p/ 60º)  digite  50 <ENTER> 
Specify next point or [Undo]: (empurre p/ 120º)  digite  50 <ENTER> 
Specify next point or [Close/Undo]: (empurre p/ 240º)  digite  50 <ENTER> 
Specify next point or [Close/Undo]:(empurre p/ 300º)  digite  50 <ENTER> ou Close ou usamos o ENDpoint para 
finalizar. 

 

   
 
2 -Inserindo um círculo no centro de nossa peça . Acionamos o comando CIRCLE: 
Só passemos o mouse no  
ponto P1 SEM Clicar  com o 
mouse , veja que fez uma 
cruz acendendo o ENDpoint. 
NOTA: Os Comandos da 
Barra de Status, POLAR, 
OSNAP, OTRACK devem 
estar acionados. Neste 
nosso caso o ENDpoint 
deverá também estar Ativo. 

 

Leve e passe o mouse no ponto 
acima e arraste até o meio.  
 NOTA: Até o momento não foi 
clicado nenhum ponto somente 
passando o mouse nos pontos. Evite 
passar o mouse em  outros pontos 
para não marcar os  pontos de 
referência. Se caso acontecer, passe 
o mouse novamentepara desmarcar. 

 

Quando acender os 
dois ENDpoint, pode 
clicar  que este é o 
centro da peça.  
 
   

Digite o Valor do Raio 
primeiro Circulo (No 
nosso caso 10) 
 
 
 
 

 
3 -Inserindo  um 
Segundo círculo 
no centro de 
nossa peça.   
Acionamos o 
comando CIRCLE  
 
Command: CIRCLE 
Specify center point 
for circle or 
[3P/2P/Ttr ( tan tan 
radius)]: 
 (Acione o  Snap 
Center e Clique o 
centro do  1º 
Círculo)  
 Specify radius of 
circle or 
[Diameter]: 15 

          

 

4 -Inserindo  a furação em 
nossa peça.   Acionamos o 
comando CIRCLE: 
Command: 
CIRCLE Specify center point for 
circle or   [3P/2P/Ttr (tan tan 
radius)]:passe o mouse no 
centro do circulo (sem clicar) 
Empurre para cima e digite o 
valor 25 <ENTER> 
correspondente  a distancia do 
furo em relação ao  centro. 
 Specify radius of circle or 
[Diameter]: 2.5 é o valor do raio 
referente.Faça a mesma coisa 
para a furação da parte de 
baixo. 
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5 -Arrendondando os cantos: 

Acionamos o comando FILLET: 
Command:FILLET 
Current settings: Mode = 
TRIM, Radius = 0.0000   
Select first object or [Polyline 
/Radius/Trim/mUltiple]: R 
Specify fillet radius 
<0.0000>: 2.5 
 
 Select first object or [Polyline 
/Radius/Trim/mUltiple]:P1 
 
Select second object:P2 

Command:    FILLET 
 Current settings: Mode = 
TRIM, Radius = 2.5000  
Select first object or Polyline 
/Radius/Trim/mUltiple]: R 
Specify fillet radius 
<2.5000>: 10 
 
Select first object or 
[Polyline/Radius/Trim/mUltiple
]:P3 
 
Select second object:P4 

 

 
 
6 – Vamos criar a projeção do tombamento da nossa peça:  - Lembramos  que para utilização das projeções 
precisamos dos botões POLAR, OSNAP e OTRACK .  
Leve  e passe o mouse  no ponto 
acima acione o  MIDpoint (Sem 
Clicar) e arraste uma até  certa 
distancia qualquer ou uma distancia 
determinada, vamos pela segunda 
opção digitamos 50 e definimos o 
ponto P1. 

Leve  e passe o mouse   no 
ponto  abaixo acione o MIDpoint 
e arraste  até    cruzar com a 
projeção do ponto P1, gerando a 
ortogonal clique o ponto P2. 

 

Empurre para 
direita e digite 
11 e clique 
<ENTER> 
 
 
 

 

Empurre para cima 
cruze com ENDpoint, 
clique para criar o 
ponto P4.  Em seguida 
Clique o botão direito 
do mouse acione a 
opção CLOSE para 
concluir o perfil lateral 
da peça. 

 
6 – Façamos agora a projeção dos furos menores: 
Acione a LINE e passe o 
mouse sobre o circulo 
para acender o Osnap  
Quadrante e arraste até 
que  cruze com 
Intersection,  clique para 
criar o  ponto P1. 

 Em seguida volte até que  
cruze com Intersection 
Clique o ponto P2 para 
finalizar a linha <ENTER>. 

 

<ENTER> 
novamente para acionar a  
LINE novamente e 
executamos a mesma coisa 
que fizemos acima. 

 

Em seguida volte também 
para o termino de nossa 
linha. 
 
Podemos Também fazer 
com furo igual abaixo. 

 
 
 
7 – Façamos a projeção da furação do meio de nossa peça. 
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Acione a LINE e passe o mouse sobre o circulo para acender o 
Osnap Quadrante e arraste até que  cruze com Intersection,  
clique para criar o  ponto P1. 
Em seguida volte na mesma direção e digite 5 (PONTO P2). 
 
 

      

Levamos o  o mouse sobre o circulo para acender o 
 Osnap Quadrante  e  e arraste até que cruze com 
projeção do ponto P2,clique para criar o ponto P3. 
 Em seguida empurre para direita, até a Intersection 
na  face da peça, e clique  para finalizar  essa 
projeção. 
<ENTER> para finalizar. 
Podemos fazer a projeção do outro furo do centro de 
nossa peça. 

 
 
 
 

8 – Após finalizar a projeção dos furos, podemos criar linhas que irão servir de linhas de centro e simetria.  

Acionamos Line 
passamos o mouse no 
centro de nossa peça, 
acendendo o snap Center 
empurramos para cima 
da peça e clicamos um 
ponto acima para iniciar 
a linha que será a nossa 
linha de centro e 
levamos para a parte 
inferior e definimos a 
nossa primeira linha de 
centro. 
 
Procedemos da mesma 
forma para a criação das 
outras linhas. 

 

 
 
 
 

9 – Mudando as cores da linhas 

 

 

                                                                                                  →  Para carregar os tipos de linhas,      
                                                                                                                                 caixa (Bylayer) do meio: 
                                                                                                                                 
                                                                           1 - clique em OTHER e na Seqüência   
                                                                           2 - Clique em LOAD para  caixa de linhas  e escolhas os tipos de linhas  
que deseja carregar. 
Podendo selecionar os tipos   com                 ajuda CTRL para alternadas ou SHIFT para um grupo.       
 E para confirmar clique OK.                     
Selecionamos desde Dasdot até Dashedx2. e cliclamos OK para o nosso carregamento de nossas linhas. 
 
Agora selecionamos nossa linha vermelha com grips, e vamos agora no nosso Bylayer linha e selecionamos 
O tipo de linha que será na nossa linha de centro, selecionamos Dasdot2.

Vamos definir uma cor para nossa linha que servirá 
como de linha de centro. 
Nota: Escolhemos uma cor para a nossa linha por que 
as cores definiram a espessura de nossa linha na hora 
de imprimir. (Podemos definir também line weight,  mas 
para melhor visualização  façamos pela cor). 
Selecionamos a nossa linha e  clicamos sem comando, 
está seleção e feita pelos grips, (São quadradinhos 
azuis na nossa linha,mas adiante falaremos sobre as 
suas funções) agora na barra Properties  cliclamos o 
Bylayer cor  e definimos uma cor. 
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9 – Criando tipos de linhas 

  

Selecionamos novamente a 
nossa linha. 

 
 
 

 
 

 

Agora tendo a nossa primeira linha 
pronta:  
Acionamento do Comando Match 
Properties na barra Standart: 
1 –Inicialmente selecionamos o objeto 
que servirá de referencia (nossa linha 
Vermelha) 
.2 – Selecionado a nossa linha, o cursor 
de torna um pincel, e medida que 
clicamos nas outras  linhas 
automaticamente será atribuídas as 
propriedades do primeiro objeto, com 
<Enter> é confirmando o comando e 
finalizado. 
OBS: Caso a escala das linhas já 
definidas (dashdot, dashdot2, 
dashdotx2) não esteja adequado  ao 
nosso desenho, temos duas opções: 
Acionamos a função LTSCALE pelo 
teclado: 
Command: ltscale 
Enter new linetype scale 
factor<1.0000>:  
A escala 1 e o fator  de 100%, se 
queremos a escala menor seria fator 
menor que 1 ex.(0.8;0.5;0.3), se 
queremos aumentar a escala seria fator 
maior que 1 ex.(1.5;2;3) 

Nota: O acionamento do Ltscale muda 
todo o padrão das linhas do desenho 
vigente. 2 – Se caso queremos mudar 
apenas para uma determinada linha, 
usamos  o comando properties. 
 

 
 

Acionada a caixa acima , 
selecionamos a linha que 
desejamos alterar, e alteramos 
não só a escala de sua linha,  
como cor, tipo de linha, layer, 
etc. 
 
Se definirmos as linhas dos furos 
como linhas não visíveis, ou 
seja, tracejadas que pode ser os 
tipos de linha (dashed, dashed2, 
dashedx2) terminaríamos nosso 
desenho aqui. 

 
 

 
 

Após selecionarmos a linha 
clicamos no bylayer linha e 
selecionamos o tipo de linha 
que desejamos, no nosso caso 
dashdot. 
Nota: As outras duas se refere 
a escala da linhas a dashdot2  é 
uma escala menor  e a 
dashdotx2 e a escala maior 
entre três. 
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Mas podemos criar uma hachura para determinar um corte total de nossa projeção. 
 

Quando acionamos o Hatch 
para criar uma hachura em uma 
determinada área, temos que  
definir o tipo de  hachura para 
nossa peça.  
Para isso se não conhecemos os 
padrões do Autocad – clicamos 
em Swatch ele abrirá uma outra 
janela com a visualização das 
hachuras, existe vários padrões, 
as mais usadas na mecânica 
seria na pasta ANSI conforme 
ao lado demonstrado. 
Definido o padrão que iremos 
usar, clicamos OK e em seguida 
clicamos o botão Pick point 
para selecionamos com ponto a 
área que receberá a hachura. 
Hatch boundary associativity 
removed. 
Command: 
Command: 
Command: _bhatch 
Select internal point: P1 
Selecting everything visible... 
Analyzing the selected data... 
Analyzing internal islands... 
Select internal point: P2 
Analyzing internal islands... 
Select internal point: P3 
Analyzing internal islands... 
Select internal point: P4 
Analyzing internal islands... 
Select internal point:<ENTER> 
para voltar a tela Hatch 

 

 

Na notação Angle o valor 0 (zero) já é definido o angulo de inclinação de hachura 
que é o de 45º  caso queiramos a inclinação para esquerda pode ser adotado o valor 
de 90 (isso inverterá a hachura).  
 
Na notação Scale o valor  corresponde a porcentagem de distancia entre as linhas 
da hachura. Isto é, se queremos maior distancia entre as linhas é só adotar um 
valor maior e ir experimentando ate um valor que se adequado ao seu desenho, 
para diminuir e o mesmo caso só que adotamos valores menor que 1 (0.75, 0.5, 
0.3, etc.) 

 
Voltando para nossa tela, 
podemos ver  botões foram 
acionados em especial o botão 
PREVIEW  onde podemos 
acionar e retornar ao desenho 
para a previsão de como ficará 
nossa hachura. 
Voltando e visualizando nosso 
desenho podemos confirmar 
<ENTER> para finalizar o 
comando com a execução da 
hachura ou <ESC> para voltar 
a tela de Hatch. 
 
Pick or press Esc to return to 
dialog or <Right-click to accept 
hatch>: <ESC> 
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19 - ZOOM 

 Acesso – View > ZOMM  
Modo Simplificado:  Z  (via Teclado) 

PAN –Permite arrastar a tela de visualização sobre o desenho, sem modificar a magnitude de visualização em 
tempo real com o auxilio do mouse. O comando pede dois pontos para o movimento da tela. 

 
Realtime - Permite modificar a magnitude, aumentando ou diminuindo dinamicamente  a visualização 
em tempo real com o auxilio do mouse.(Acione o Comando e clique na tela segurando o botão esquerdo 
arrastando para cima e para baixo respectivamente). 

 
Window – Mostra a imagem definida por uma janela indicada pelos pontos de sua diagonal. Aciona as outras 
Opções do Comando Zoom. 

 

Dynamic - Faz um controle de visualização dinâmica sobre o desenho, permitindo aproximar ou afastar de 
um local do desenho. Dentro do comando um quadro aparece inicialmente, representando a área do zoom 
anterior. Com o botão de pick do mouse o X do quadrado muda para uma seta , permitindo aumentar (afastar 
do desenho) ou diminuir (aproximar do desenho) a área de Zoom. Move-se o quadrado sobre a área que 
deseja visualizar e completa o comando com <Enter>. A linha tracejada verde representa o limite do desenho, 
e se o quadrado com X sair desta área, aparece uma ampulheta , que significa que o comando vai forçar uma 
regeneração no desenho. 

 
Previous – Retorna a imagem anterior do último comando Zoom. 

 

Scale -  Multiplica a tela atual por uma nova relação de zoom. Ex: Zoom 2x aumenta a tela atual 2 vezes. - 
zoom .3x reduz a tela para 30% da tela atual. zoom 2 aumenta 2 vezes a tela em relação a tela definida pelo 
Limits. 

 
Center -Permite fixar um ponto e aplicar o zoom sobre este ponto. 

 
 In - Permite aproximar do desenho (fator de escala 2). 

 Out –Permite afastar do desenho (fator de escala 0.5). 

 All - Visualiza todo o desenho mais o limite definido pelo comando Limits. 

 Extend - Mostra a extensão máxima que o desenho pode ocupar na tela. 
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Tutorial  

 
 
 

 
 
1 - Criamos o 1º círculo de raio 7.5. -   
Acionamos o comando CIRCLE: 
   Command: CIRCLE Specify center point for 
circle or   [3P/2P/Ttr (tan tan 
radius)]:(Clique  um ponto para o centro 
do Círculo) 
 Specify radius of circle or[Diameter]: 
7.5<ENTER> 
 
 

2 - Criando 2º círculo de raio 8 - distante do centro do primeiro 
42,12.4 -   Acionamos o comando CIRCLE: 
Command:CIRCLE 
 Specify center point for circle or  [3P/2P/Ttr (tan tan radius)]: 
 2.1)  _from   ( Segure o SHIFT no teclado e clique o botão direito do 
mouse) opção FROM  
2.2) Base point: (Selecione o CENTERpoint  ponto P1) 
2.3)<Offset>: @-42,12.4<ENTER> (Digitamos a distancia do ponto 
de referencia, ao ponto de início de nosso novo circulo) 
 Specify radius of circle or[Diameter]: 8<ENTER> 
 
3 – Criamos uma linha qualquer a partir do centro do 1º circulo 
 
4- Acionamos o Comando Fillet para o arredondamento do 1º canto: 
Command: FILLET 
Current settings: Mode = TRIM, Radius = 0.0000 
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: R 
(clicamos o botão direito do mouse e selecionamos a opção 
RADIUS) 
Specify fillet radius <0.0000>: 12<enter> é o 1º Raio  
Select first object or [Undo/Polyline/Radius/Trim/ Multiple]: (Clique 
em P2) 
Select second object or shift-select to apply corner:  
(Clique em P3) 
 
5 – Acionamos o comando Circle para concordar um circulo na 
extremidade direita: 
Command: CIRCLE  
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: T 
(clicamos o botão direito do mouse e selecionamos a opção 
TTR) 
Specify point on object for first tangent of circle: (Clique em P4) 
Specify point on object for second tangent of circle: (Clique em P5) 
Specify radius of circle <0.0000>:13<ENTER> 
  

 

6 – Acionamos o comando Trim para cortar os excessos – conforme  as linhas 
mais finas da figura. 
    Command: TRIM 
    Current settings: Projection=UCS, Edge=Extend 
    Select cutting edges ... 
    Select objects or <select all>: <ENTER> (cliclamos enter para selecionar  
todo o desenho) 
    Select object to trim or shift-select to extend or 
    [Fence/Crossing/Project/Edge/eRase/Undo]: (Clique em P6) 
    Select object to trim or shift-select to extend or 
    [Fence/Crossing/Project/Edge/eRase/Undo]: (Clique em P7) 
 
7 – Acionamos o Comando Line para uma linha de vai de um ponto de referencia 
ate o tangenciamento no circulo. 
Command: LINE 
      Specify first point: 
       7.1)  _from   ( Segure o SHIFT no teclado e clique o botão direito do mouse)  
               opção FROM  
       7.2) Base point: (Selecione o CENTERpoint  ponto P7) 

                                                            7.3)<Offset>: Digitamos a distancia do ponto de referencia,ao ponto de início 
                                                                  de nossa linha  @25,6 (temos o ponto P8) 
                                                             Specify next point or [Undo]: 

7.4)_tan  ( Segure o SHIFT no teclado e clique o botão direito do mouse) 
opção  TANGENT: (Clique em P9 para tangenciar o circulo ) <ENTER> 
 
8 – Acionamos o comando Fillet para finalizar  a linha 
Command: FILLET 
Current settings: Mode = TRIM, Radius = 12.0000 
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: R (clicamos o 
botão direito do mouse e selecionamos a opção RADIUS) 
 
Specify fillet radius <12.0000>: 8.5<enter> é o  Raio de concordância 
Select first object or [Undo/Polyline/Radius/Trim/ Multiple]: (Clique em 
P10) 
Select second object or shift-select to apply corner: (Clique em P11) 
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8 – Acionamos o comando Line primeiramente 
para criar a boca da nossa chave. 
Command: LINE  
Specify first point: P12(Centro do circulo) 
Specify next point or [Undo]: 9 (empurre o mouse 
- a polar 210º e digite o valor 9) Command: 
OFFSET 
Current settings: Erase source=No  Layer=Source  
OFFSETGAPTYPE=0Specify offset distance or 
[Through/Erase/Layer] <Through>: 3 (distancia 
da nossa paralela) 
Select object to offset or [Exit/Undo] <Exit>: P13 
(selecione objeto) 
Specify point on side to offset or 
[Exit/Multiple/Undo] <Exit>: P14(selecione um 
lado da nossa copia paralela) 
 
Select object to offset or [Exit/Undo] <Exit>: P15 
(selecionamos novamente o objeto) 
Specify point on side to offset or 
[Exit/Multiple/Undo] <Exit>: P16 
<enter>(selecione o outro lado para a nossa 
outra copia paralela) 
 

 
 

 
 

 
10 - Acionamos o comando Circle para o fundo da boca da chave.  
Command: CIRCLE 
 Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 
P17(ENDpoint em P17) 
Specify radius of circle or [Diameter]: 9 (raio 9 ou clique o outro 
ponto P18) 
 
11 - Acionamos o comando Trim para cortar as linhas para abrir a 
boca de nossa chave 
Command: TRIM 
Current settings: Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects:  P19 e P20 <enter> (selecione os objetos de 
referencia para o nosso corte) 
Select object to trim or shift-select to extend or 
[Fence/Crossing/Project/Edge/eRase/Undo]: P21, P22,  
P23<enter> (selecione os objetos  que irão ser cortados) 
 
Acionamos o comando trim novamente com um <enter> 
 
Command: TRIM 
Current settings: Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects:  P24 e P25<enter> (selecione os objetos de 
referencia para o nosso corte) 
Select object to trim or shift-select to extend or 
[Fence/Crossing/Project/Edge/eRase/Undo]: P26, P27,  
P28<enter> (selecione os objetos  que irão ser cortados) 
 
NOTA:  Repare que nesse caso foi preferível abrir a boca da nossa 
chave em duas fase com o trim  e não fazer uma seleção total 
com um <enter> desde a primeira seleção por que, se o fizer o 
comando “puxará” todos os pontos de referencia do desenho e 
começara a quebrar muito as linhas, precisando posteriormente 
apagar segmentos de linhas deixadas para trás. 
 
12 - Acionamos o comando Polylgon e criamos um sextavo no 
centro do outro circulo. 
Command: POLYGON 
 Enter number of sides <4>:6 (descriminamos o nº de lados) 
Specify center of polygon or [Edge]: P30 ( centerpoint em P30) 
Enter an option [Inscribed in circle/Circumscribed about circle] 
<I>: C ( clicamos o botão direito do mouse e selecionamos 
a opção Circumscribed) isto por que a cotagem do sextavado 
esta pela sua aresta. 
Specify radius of circle: 4.75 (definimos o raio de 4.75 por  que o 
diametro  da aresta é 9,5) 
 
13 – Acionamos o comando Offset e Trim  para finalizar com as 
nervuras de nossa chave. 
Command: OFFSET 
Current settings: Erase source=No  Layer=Source  
[Through/Erase/Layer] <Through>: 1.5 (distancia da nossa 
paralela) 
 
Select object to offset or [Exit/Undo] <Exit>:Selecione uma a 
uma cada linha para criar nossa nervura 
 
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: 
 (Clique internamente na nossa chave para todas as linhas 
para criar as linhas vermelhas da figura ao lado) 
 
Select object to offset or [Exit/Undo] <Exit>: 
Command: TRIM 
Current settings: Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects or <select all>: <enter> 
 
Select object to trim or shift-select to extend or 
[Fence/Crossing/Project/Edge/eRase/Undo]: Recorte todas as 
linhas e depois delete todas as linhas que sobraram. 
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23 - MOVE 

 Acesso – MODIFY> Move 
Modo Simplificado:  M  (via Teclado) 

A partir do acionamento do Comando Move: 
1 –Inicialmente precisamos Selecionar o objeto que queremos mover, selecionamos por Pick, window, etc. e <Enter> 
2 – A partir de selecionado nosso objeto, é solicitado um ponto de referência para o arrasto do objeto, se precisamos 
um ponto de precisão usamos o Osnap para exatidão de captura e confirmamos com <Enter> 
3 – Após a escolha do ponto do arrasto é solicitado o outro ponto de fixação, que também poderá ser clicado com ou 
sem precisão, <Enter>para confirmar a movimentação 
Formato: 
Command: Move 
Select objects: (Selecione objetos) <ENTER> 
Select objects: Specify base point  or  displacement: P1 
Specify second point of displacement or  
<use first point as displacement : P2 
 
 
 

 

 
24 - COPY 

 Acesso – MODIFY> Copy 
Modo Simplificado:  CO ou CP  (via Teclado) 

A partir do acionamento do Comando Copy: 
Segue da mesma forma que o comando Move → Seleção do Objeto  → Ponto 

de Arrasto → Ponto de Fixação. 
As mudanças entre um comando e outro e que Comando Move desloca o nosso 
objeto e Comando Copy cria uma cópia identica e no comando Copy tem uma 
opção de criar multiplas cópias a partir da seleção  do objeto. 
 
Command: COPY 
Select objects: 1 found 
Select objects: 
Specify base point or displacement, or [Multiple]:  
Specify second point of displacement or <use first point as displacement>:( segundo ponto ou deslocamento)Multiple ou 
M: permite a geração de cópias múltiplas até que se digite a tecla <ENTER>. 

 

 25 - MIRROR 
 Acesso – MODIFY> Mirror 
Modo Simplificado:  MI (via Teclado) 

A partir do acionamento do Comando Mirror: 
1 – Inicialmente temos que selecionar o objeto a ser espelhado, confirmamos <Enter> para seqüência. 
2 – Agora é solicitado o um ponto que será a mediana do nosso objeto, <Enter> 
3 – Pede-se o segundo ponto que poderá ser um ponto determinado ou um ponto qualquer desde que esteja ligado o 
Ortho [F8] ou Polar [F10]. 
4 – A partir do segundo clique, é perguntado se queremos deletar o objeto de origem e manter somente o seu espelho 
<Y> ou <Enter> que como default diz para não deletar o objeto de origem.   

 
Commmand: MIRROR 
Select objects: 1 found Selecionamos nosso objeto 
<ENTER> 
Specify first point of mirror line: :  
 (primeiro ponto da linha de espelhamento) P1 
 Specify second point of mirror line: (segundo ponto da 
linha de espelhamento) P2<Ortho on>ou <Polar on> 
Delete source objects? [Yes/No] <N>:<ENTER>(deleta o 
objeto gerador do mirror ( sim ou não) 

 
 

 
26 - ROTATE 

 Acesso – MODIFY> Rotate 
Modo Simplificado:  RO (via Teclado) 

A partir do acionamento do Comando Rotate: 
1 – Inicialmente temos que selecionar o objeto a ser rotacionado, confirmamos <Enter> para seqüência. 
2 – Agora é solicitado o um ponto que será o ponto central de rotação do nosso objeto, <Enter> 
3 – Nesse momento podemos perceber que “girando” o mouse, a nossa seleção do objeto gira junto e Pede-se para 
definir o ângulo que rotacionará o nosso objeto seguindo a orientação anti-horário ou ponto para fixar a inclinação. 
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Command:ROTATE 
Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0 
Select objects: 1 found 
Select objects: 
Specify base point: P1 
Specify rotation angle or [Reference]: 30 ( digite o angulo em seguida 
<ENTER>) 
 
A opção Reference permite selecionar um angulo de referencia pelo Valor 
ou por dois pontos. 
Command: ROtate 
Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0.00 
Select objects: Specify opposite corner: 7 found 
Select objects: 
Specify base point: P1 
Specify rotation angle or [Reference]: R 
Specify the reference angle <0.00>: P2 (se entrar com o valor do angulo 
poderá definir a subtração ou adição do angulo pelo seus sinais respectivos) 
  Specify second point: P3 
Specify the new angle: 45 

 

 

 
28 - OFFSET 

 Acesso – MODIFY> Offset 
Modo Simplificado:  O (via Teclado) 

A partir do acionamento do Comando Offset: 
1 – Inicialmente é necessário entrar com o valor a distância para a  cópia paralela do nosso objeto <Enter>  
2 – Agora podemos selecionar  a linha ou objeto que queremos gerar sua cópia paralela <Enter> 
3 – Na seqüência é solicitado que clicamos na nossa tela gráfica o lado (direita, esquerda – acima, abaixo) que 
queremos a cópia, o comando se mantêm ativo, gerando cópias até das próprias cópias até confirmamos com <Enter> 
para a sua finalização. 
Nota:  O comando em Polylines (Retângulos, círculos, elipse, etc.) geramos formas concêntricas, com a distancia 
definida inicialmente no comando. 

 
Command: OFFSET 
Specify offset distance or [Through] <0.0000>:(distância) 5 
Select object to offset or <exit>:(selecione o objeto para offset)P1 
Specify point on side to offset:>: (lado para offset) P2 
Select object to offset or <exit>:(selecione o objeto para offset)P3 
Specify point on side to offset:>: (lado para offset) P4 
Select object to offset or <exit>:(selecione o objeto para offset)P5 
Specify point on side to offset:>: (lado para offset) P6 
Select object to offset:Confirme <ENTER> para finalizar o comando. 
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Tutorial 

     

Criando o 1º Retangulo: 
Command: _rectang 
Specify first corner point or 
[Chamfer/Elevation/Fillet/Thickness/Width]:P1 
Specify other corner point or [Dimensions]: 
@100,75 
 
Criando o 2º Retangulo: 
Command: RECTANG 
Specify first corner point or 
[Chamfer/Elevation/Fillet/Thickness/Width]:P2 
Specify other corner point or [Dimensions]: 
@20,20 

 
Fazendo  uma cópia do 2º Retângulo: 
Command: _copy 
Select objects: 1 found (Selecione clicando o ponto P1)<ENTER> 
Specify base point or displacement, or [Multiple]:P2<ENTER> 
 Specify second point of displacement or <use first point as 
displacement>: P3<ENTER>  
 
Vamos Rotacionar a nossa Cópia: 
Command: _rotate 
Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0 
Select objects: Specify opposite corner: 1 found (Selecione clicando o 
ponto P1)<ENTER> 
Specify base point:(clicamos um ponto que servirá de base para a 
Rotação P2)<ENTER> 
Specify rotation angle or [Reference]: 45 

 
    Movendo o 2º retangulo para sua posição 

                                                                                          Command: m 
                                                                               MOVE 

                                                                                                                     Select objects: Specify opposite 
                                                                                                  corner: 1 found                             

                                                                                                        (Selecione clicando o ponto  P1)<ENTER> 
                                                                              

 
                                                                                                          Select Specify base point or displacement:  

                                                                 (Passe o mouse sobre P’ (não clique) Fará uma  marca de cruz no ponto), 
                                                              leve o mouse para o ponto P’’, traga o mouse para o centro da peça até  
                                                                 cruzar a linhas ortogonais de polar, acendeu os dois é o nosso centro 

clique 
                                                                  o ponto P2. 
 
                                                                Specify second point of displacement or <use first point as displacement>: 

                                                           Leve o mouse até o MIDpoint conforme a figura ao lado e clique ponto P3. 
 

 
 

Fazendo uma 
Cópia para o 
outro lado 
Command: cp 
COPY 
Select objects: 1 
found(Selecione 
clicando o ponto 
P1) <ENTER> 
 
Specify base point 
or displacement, or 

[Multiple]: MIDpoint P2 
 Specify second point of  
displacement or <use first point as displacement>: 
MIDpoint P3 

 
Vamos cortar as pontas dos 
retangulos 
Command: tr 
TRIM 
Current settings: 
Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects: Specify opposite 
corner: 1 found  
(Selecionamos  a nossa linha 
de corte que será  nosso 
 retangulo maior clicamos como 
o  ponto P1)<ENTER> 

 
Select object to trim or shift-select to extend or 
[Project/Edge/Undo]: 
Para cortar o queremos clicamos como o  ponto P2 e P3 
<ENTER> 
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Vamos cortar a parte interna do retângulo 
Command: tr 
TRIM 
Current settings: Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects: Specify opposite corner: 1 found  
(Selecionamos  a nossa linha de corte que será agora 
 os bicos clicamos como o  ponto P1 e P2)<ENTER> 
 
Select object to trim or shift-select to extend or [Project/Edge/Undo]: 
Para cortar o queremos clicamos como o  ponto P3 e P4 <ENTER> 

 
Vamos Criar um retângulo no canto Superior utilizando o comando 
From de referencia  a um ponto p/ posição final. 
 
Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 
 
1)  _from( Segure o SHIFT no teclado e clique o botão direito do mouse) 
opção FROM  
2) Base point: (Selecione o ENDpoint  ponto P1) 
3)<Offset>: Digitamos a distancia do ponto de referencia, 
 ao ponto de início de nosso retangulo @-10,-10<ENTER> 
 4) Specify other corner point or [Dimensions]:   
Agora executamos nosso retângulo em função relativa ao ponto @-20,-20 
<ENTER> 

 
Vamos Criar um circulo no canto Superior utilizando o comando From 
de referencia  a um ponto p/ posição final. 
 
Command: c 
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 
 
1)  _from( Segure o SHIFT no teclado e clique o botão direito do mouse) 
opção FROM  
2) Base point: (Selecione o ENDpoint  ponto P1) 
3)<Offset>: Digitamos a distancia do ponto de referencia, 
 ao ponto de centro de nosso circulo @-15,10<ENTER> 
 
 4)Specify radius of circle or [Diameter]: 5<ENTER> 

 
Fazendo as outras cópias do circulo  
Command: cp 
COPY 
Select objects: 1 found(Selecione clicando o ponto P1)<ENTER>  
Specify base point or displacement, or [Multiple]: M (acionamos a opção 
Multiplique) 
Specify base point: CENterpoint P2 
 Specify second point of displacement or <use first point as displacement>:  
 (Empurramos o mouse a esquerda e digitamos ) 15 
Specify second point of displacement or <use first point as displacement>:  
(Podemos continuar inserindo outros furos) 15<ENTER> 
 

 
Fazendo o Rasgo do bilongo  
Command:CIRCLE 
Command: _circle Specify center point for circle or [3P/2P/Ttr (tan tan  
radius)]: _from Base point: ENDpoint P1  
<Offset>: @20,20 
 
Specify radius of circle or [Diameter]: 7.5 
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Fazendo o Rasgo do bilongo  
Command:CIRCLE 
Command: _circle Specify center point for circle or [3P/2P/Ttr (tan tan  
radius)]: 
 (passe o mouse no centro do circulo empurre a linha de 
projeção a 30º digitamos 30 que é distancia entre os pontos <ENTER>  
 
Specify radius of circle or [Diameter]: 7.5<ENTER> 

 
Criando as linhas tangentes ao circulo 
Command: L 
LINE Specify first point: _tan to 
( Segure o SHIFT no teclado e clique o botão direito do mouse) 
 opção Tangent <Clique P1> 
 
Specify next point or [Undo]: _tan to 
( Segure o SHIFT no teclado e clique o botão direito do mouse) 
 opção Tangent <Clique P2> 
Specify next point or [Undo]: <ENTER> 
 
Repita os passos para criação da linha acima e  

 
Após realizarmos com o Comando Trim para cortar 
as linhas internas para ficar como o desenho ao lado .  
 
Vamos criar outro circulo usando  pontos Temporários. 
 
Command: c 
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: _tt 
( Segure o SHIFT no teclado e clique o botão direito do mouse) 
 Selecione opção Temporary track point 
Specify temporary OTRACK point:  
Passe o mouse no ponto P1 empurre para a direita e digite)  15 <ENTER> 
 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: _tt 
( Segure o SHIFT  novamente e clique o botão direito do mouse) 
 Selecione opção Temporary track point 
Specify temporary OTRACK point: 
 (Empurre para baixo e digite ) 15<ENTER> 
 
Specify radius of circle or [Diameter] <7.5000>: 5 <ENTER> 
 
OBS: Caso a projeção do ponto P1 esteja atrapalhando 
a projeção, volte e passe o mouse no ponto P1 para desmarcar 
a cruzinha. 

 
Construindo as partes concêntricas 
Command: o 
OFFSET 
Specify offset distance or [Through] <0.0000>: 
(Definimos a distancia da copia paralela ) Digitamos 5<ENTER> 
Select object to offset or <exit>:P1 
Specify point on side to offset: (cliclamos um ponto para fora)P2 
Select object to offset or <exit>:P3 
Specify point on side to offset:P4 
Select object to offset or <exit>:P5 
Specify point on side to offset:P6 
Select object to offset or <exit>:P7 
Specify point on side to offset:P8 
Select object to offset or <exit>:P9 
Specify point on side to offset:P10 
Select object to offset or <exit>: <ENTER> 



 

ESCOLA DE ENGENHARIA DE LORENA – EEL USP                                                                                    -Folha. 35 

Agora criamos um retângulo de 6x5. Da mesma forma que 
começamos, criamos um retângulo para movermos para a sua posição 
final. 
Copiamos para outro lado respectivo. Logo após uma outra cópia nos 
rotacionamos para completar o desenho e usando o Comando Trim 
para fazer os cortes necessários. 
 
1)Command: _rectang 
Specify first corner point or 
[Chamfer/Elevation/Fillet/Thickness/Width]: 
Specify other corner point or [Dimensions]: @6,5 
 
2)Command: MOVE 
Select objects: 1 found   P1<ENTER> 
Specify base point or displacement: MIDpoint P2 
 Specify second point of displacement or  
<use first point as displacement>:MIDpoint P3 
 
3)Command: COPY 
Select objects: 1 found P1<ENTER> 
Specify base point or displacement, or [Multiple]:MIDpoint P2 
Specify second point of displacement or <use first point as 
displacement>:MIDpoint P3 
 
4)Command: ROTATE 
Current positive angle in UCS:  ANGDIR=counterclockwise  
ANGBASE=0 
Select objects: Specify opposite corner: 1 found P1<ENTER> 
Specify base point:P2 

Specify rotation angle or [Reference]: 90 
 
5) Repetimos os  passos 2 e 3 para mover e copiar para ficar como a figura seguinte. 
6) Cortamos as partes que internas com o TRIM. 
Command:TRIM 
Current settings: Projection=UCS, Edge=Extend 
Select cutting edges ... 
Select objects: Specify opposite corner:<ENTER>( Com essa resposta o comando Trim todo desenho selecionado.)  
Select object to trim or shift-select to extend or [Project/Edge/Undo]: 
Agora é so cliclar onde temos que cortar, neste nosso caso especifico que se trata de retângulos, temos que clicar duas 
vezes para o vão seja aberto. 

 

 

 Para finalizar nossa peça criamos o arco a esquerda 
Current  
Command:ARC 
 (Melhor selecionar pelo caminho - Draw - Arc -Start, End e Radius) 
Essa opção se consegue mais facilmente analisar o tipo de arco que precisamos. 
Command: _arc Specify start point of arc or [Center]: ENDpoint P1 
(consideramos normalmente a posição anti-horário) 
 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc:ENDpoint P2 
Specify center point of arc or [Angle/Direction/Radius]: 
 _r Specify radius of arc: 100 
Usamos o Comando Trim para Cortar alinha do Retângulo  e finalizamos no 
desenho. 
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27 – ARC 

 Acesso – DRAW> ARC 
Modo Simplificado:  A  (via Teclado) 

Para a execução de Arcos com o comando ARC, precisamos identificar os 
pontos característicos do desenho ou os dados que temos para poder trabalhar 
satisfatoriamente.  
Lembramos primeiramente que a leitura do AutoCad, esta configurado sempre 
para a leitura angular anti-horário.  
Acionado pelo teclado ou pelo icone ele estará pronto para a execução de um 
arco por 3 pontos. O melhor acesso  é pelo menu Pull Down como ao lado, por 
que voce pode selecionar as suas opções. 

3 POINT - 
Define o arco com 
3 pontos de sua 
circunferência 

Command: a 
ARC Specify start point of arc 
or [Center]:P1 
Specify second point of arc or 
[Center/End]:P2 
Specify end point of arc:P3 

 [Start, 
Center, End] - 
Início, centro e fim 

 

Command: Arc 
Command: _arc Specify start 
point of arc or [Center]: P1 
Specify second point of arc or 
[Center/End]: _c Specify center 
point of arc: P2 
Specify end point of arc or 
[Angle/chord Length]: P3  

 

[Start, Center, 
Angulo] - Início, 
centro e o ângulo 
relativo. 

 

Command: 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _c Specify 
center point of arc: P2 
Specify end point of arc or [Angle/chord Length]: _a 
Specify included angle: Valor do Angulo  

 

[Start, Center, 
Length] - Início, 
centro e o 
comprimento da 
Corda 

 

Command: 
Command: _arc Specify start point of arc or [Center]:P1 
Specify second point of arc or [Center/End]: _c Specify 
center point of arc:P2 
Specify end point of arc or [Angle/chord Length]: _l Specify 
length of chord: Comprimento da Corda 

 

[Start, End, 
Direction] - Início, 
Fim e um ângulo de 
tangente  

 

Command: 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc:P2 
Specify center point of arc or [Angle/Direction/Radius]: _d 
Specify tangent direction for the start point of arc: Define o 
Angulo  da tangente 

 

[Start, End, Radius] 
- Início, Fim e um 
raio d concordância 

 

Command: 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc: P2 
Specify center point of arc or [Angle/Direction/Radius]: _r 
Specify radius of arc: Entre com valor do Raio 

 

[Start, End, Angle] - 
Início, Fim e um 
ângulo de projeção 

 

Command: 
Command: _arc Specify start point of arc or [Center]:P1 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc: P1 
Specify center point of arc or [Angle/Direction/Radius]: _a 
Specify included angle: Ângulo de Inclusão ( Projeção) 

 

[Center, Start, End] 
– Centro, Início e fim 

 

Command: 
Command: _arc Specify start point of arc or [Center]: _c 
Specify center point  of arc: P1 
Specify start point of arc: P2 
Specify end point of arc or [Angle/chord Length]: P3 
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[Center, Start, 
Angulo] - Início, 
centro e o ângulo 
relativo. 

 

Command: 
Command: _arc Specify start point of arc or [Center]: _c 
Specify center point of arc: P1 
Specify start point of arc: P2 
Specify end point of arc or [Angle/chord Length]: _a 
Specify included angle: Insira o valor do Angulo. 

 

[Center, Start, 
Length] Centro,Início 
e o comprimento da 
Corda 

 

Command: 
Command: _arc Specify start point of arc or [Center]: _c 
Specify center point of arc: P1 
Specify start point of arc: P2 
Specify end point of arc or [Angle/chord Length]: _a 
Specify included angle: Comprimento da Corda 

 
[Continue] 
Continua onde parou  

Command: 
Command: _arc Specify start point of arc or [Center]: 
Specify end point of arc: 

 

 29 – MATCH Properties 
 Acesso – MODIFY> Match Properties 
 

É utilizado para trocar propriedades das entidades ou objetos do desenho, como cor tipo de linha, etc.  
A partir do acionamento do Comando Match properties: 
1 –Inicialmente selecionamos o objeto que servirá de referencia . 
2 – Selecionado a nossa referencia o cursor de torna um pincel, e medida que clicamos nas entidades ou objetos 
automaticamente será atribuídas as propriedades do primeiro objeto, com <Enter> é confirmando o comando e 
finalizado.  
 

 
30 - LIST 

 Acesso – TOOLS> Inquiry > List 
Modo Simplificado:  LI (via Teclado) 

O comando List é uma ferramenta para listar todos os dados sobre determinado objeto ou entidade. 
Acionamos o comando List: 
1- Selecionamos a entidade que desejamos saber os seus dados e referencias de posicinamento no plano WCS, seus 
dados serão listados na Barra de comando. 
Command: LIST 
Select objects: 1 found: P1 
CIRCLE    Layer: "CONTORNO" 
center point, X=   4.9374  Y=-120.9738  Z=   0.0000 
            radius   30.0000     circumference  188.4956    area 2827.4334 

P1

 

 
31 - DIST 

 Acesso – TOOLS> Inquiry > Dist 
Modo Simplificado:  DI (via Teclado) 

O comando Dist determina a distancia entre pontos de objetos no desenho e seus pontos relativos ao plano vigente.  
Formato: 
Acionamos o comando Dist: 
1- Selecionamos os pontos com Osnap, para ter uma precisão e clicamos os pontos da entidade que desejamos “medir”.  
Command: DIST Specify first point: (primeiro ponto) Specify second point: (segundo 
ponto) 
Distance = 117.4319=(distância calculada),  Angle in XY Plane = 336=(Angulo do 
planoXY), Angle from XY Plane = 0=Angulo com o plano XY)          
 Delta X = 106.8758=(valor),  Delta Y = -48.6601=(valor),   Delta Z = 0.0000=(valor) 

 

 
32 - AREA 

 Acesso – TOOLS> Inquiry > Area 
Modo Simplificado:  AREA (via Teclado) 

O comando AREA é uma ferramenta para calcular a Área e o perímetro de figuras em tela gráfica. 
Se queremos obter o valor de uma determinada área podemos seguir os passos abaixo ou se for uma área fechada 
podemos acionar o comando e acionar a opção Object e selecionarmos a nossa área como se fosse uma hachura 
clicando dentro da determinada área.  
Command:AREA 
Specify first corner point or [Object/Add/Subtract]: P1 
Specify next corner point or press ENTER for total:P2 
Specify next corner point or press ENTER for total: P3 
Specify next corner point or press ENTER for total: P4 
Specify next corner point or press ENTER for total: P5 
Area = 3377.9770, Perimeter = 282.9298  
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 34 - CAL  Acesso  
 ( CAL ,  via teclado) ou 'CAL modo transparente 

O comando CAL apesar de não ser muito utilizado para fazer cálculos  pois não uma interação com o usuário, pois de 
realizar seus cálculos através da linha de comando. As vezes e uma boa saída da descobrir pontos geométricos.  
Utiliza-se para fazer cálculos com as expressões ( ) para expressões com grupos, ^ para exponenciação, + - para 
adição e subtração e * / para multiplicação e divisão. 
Formato: 
Commmand: CAL 
Initializing..>>Expression: (12*12)/2<ENTER>  72.0 

Formato: 
Commmand: CAL 
Initializing..>>Expression: end+[20,10]>>Specify entidy for END snap; 

Command: Circle 
CIRCLE Specify center point for circle 
or(3P/2P/Ttr):'CAL 
Initializing..>>Expression:(MID+CEN)/2 
Specify entidy for MID snap:P1 
Specify entidy for CEN snap:P2 
Specify radius for circle or (diameter)>: 'CAL 
Initializing..>>Expression:1/5*rad<ENTER> 
>>select circle, arc or polyline segment for RAD 
function:P3  4.0  

 
 

 35 -STRETCH 
 Acesso – MODIFY> Stretch 
Modo Simplificado:  S (via Teclado) 

A partir do acionamento do Comando Stretch: 
1 – Obrigatóriamente temo que Selecionar o objeto com a seleção window-crossing, através de abertura de janela por 
dois pontos da direita para esquerda. <Enter> 
2 – Após a seleção podemos clicar um ponto de referência que pode do objeto ou não, e clicar um novo ponto ou um 
adicionar um valor positivo ou negativo. 
Command: stretch 
Select objects to stretch by crossing-window or crossing-polygon... 
Select objects: Specify opposite corner: P1 1 found 
Select objects: 
Specify base point or displacement: P2<ENTER> 
STRETCH 
Specify second point of displacement: :first point>: Crossing 
second point :P2<ENTER> 
Base point:P3 
New point: P4 
OBS: A seleção da entidade deverá ser por janela crossing. 

 
Permite mover ou esticar partes selecionadas de 

um grupo de entidades. 
 

 
36 -BREAK 

 Acesso – MODIFY> Break 
Modo Simplificado:  BR (via Teclado) 

A partir do acionamento do Comando Break: 
Podemos quebrar linhas, retangulos, circulos, etc. através de dois pontos clicados sobre o objeto, esses pontos  podem 
ser aleatórios ou em pontos especifícos, para isso temos que “forçar” com as funções do Osnap, isto é, mesmo com as 
opções do Osnap ligadas, temos que clicar o icone especifico ou atalho pelo teclado. Lembre-se para arcos e circulos a 
orientação do sentido de leitura,faz diferença na hora de quebrar esses 
elementos. 
Formato: 
Command: Break 
Select objects: (Selecione os pontos P1 e P2) 
Enter first point:<ENTER> 

 
 

 
37 -DIVIDE 

 Acesso – DRAW> Point > Divide 
Modo Simplificado:  DIV (via Teclado) 

Divide as  entidades em intervalos com medidas iguais. 
Acionamos o comando Divide: 
1 – Selecionamos a linha ou nosso objeto que queremos dividir. 
2 – Entre com o número de divisões e confirme com <Enter>. 
Command: DIV 
Select object to divide :Selecione  a linha que irá dividir 
Enter number of segments or[block]: 8 <ENTER> 
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38 -MEASURE 
 Acesso – DRAW> Point > Measure 
Modo Simplificado:  ME (via Teclado) 

Permite dividir uma entidade com POINT ou blocos, com uma dimensão pré-determinada.  
Acionamos o comando Measure: 
1 – Selecionamos a linha ou nosso objeto que queremos “marcar” as distancias. 
2 – Entre com o valor da distancia que desejamos inserir e confirme com <Enter>. 
Command: ME 
Select object to measure:Selecione a linha que insere a medida 
Specify length of segment or Block:: Comprimento  8 

 
NOTA:- Para trabalhar com o comando Divide ou Measure  temos que configurar POINT STYLE para poder ver os pontos 
de marcação. 
- O AutoCAD não divide  ou insere a medida quebrando a entidade e sim marcar pontos que definem o local da divisão. 
- Para poder “capturar” os pontos, precisamos do Osnap – Node  

 
39 -POLYLINE 

 Acesso – DRAW> Polyline 
Modo Simplificado:  PL (via Teclado) 

O comando Polyline ou Pline, funciona como o comando Line, só que quando desenhamos com Line, cada segmento e 
uma entidade, já numa construção de desenho com polyline, constitui em um só desenho, se desejamos deletar 
alguma parte, deletamos todo ele.  
 Também podemos na sequencia de construção alterar, para arcos e  formatar espessuras trabalhando com a suas 
opções, conforme o desenho abaixo. Lembramos que há uma dificuldade de edição dessas espessuras, se explodirmos 
com o comando Explode, ela perderá as suas qualidades de polylines e se transforma em uma linha comum.  
Formato: 
Command: PLINE 
From point: <P1> 
Current line width is 0,00 
Arc/ Close/ Halthwidth/ Length/ Undo/ Width <Endpointof line> 
Modos: 
ARC – Desenha segmentos de arcos na polinha. 
CLOSE – Fecha um polígono, unindo o último ponto ao primeiro. 
HALFWIDTH- Define a meia espessura inicial e final da pline. 
LENGTH- Permite desenhar um segmento ,definindo seu comprimento 
a partir do último segmento executado (se for positivo, terá o mesmo 
sentido e se negativo, terá o sentido invertido. 
UNDO – Defaz o último subcomando utilizado. 
WIDTH – Define a espessura da linha. 

 

 
 

 
41 -MLINE 

 Acesso – DRAW > Mline 
Modo Simplificado:  ML (via Teclado) 

A partir do acionamento do Comando Mline: 
1 –Temos que confirmar os dados, normalmente o default  
o autoCad desenhará duas linhas (standanrd) com a 
distancia entre elas de 20 unidades (Scale=20.00) se 
criarmos uma parede em m (metros por ex.) temos que 
configurar o Scale para 0.15 que o padrão para uma parede 
comum,  A justification esta =TOP , quer dizer que temos 
inserir as medidas das linhas da parede por fora , podemos 
definir por Zero que é uma linha  imaginaria central ou 
BOTTOM que é a medida interna da nossa linha dupla.  

2 – Configurando esses dados podemos construir as 
paredes como trabalhamos com a line.  

  O comando Mline e o comando para 
construção dde linhas paralelas com cores e 
traços complexos, dependendo do que 
queremos realizar. Esse tipo de linhas pode 
ser bem util para o desenhos dem 
arquitetura, mas exige uma atenção  com as 
medidas que deseja no final.  
 Podemos fazer sua edição, permitindo 
interromper, unir e editar as intersecções 
com a caixa de dialogo – acesso pelo 
caminho – Modify  → Object  → Multiline. 
Criamos novos tipos e estilos de linhas multiplas com a caixa de dialogo – 
acesso  Format  →Multiline Style.  
  
Justification- Posiciona a linha mestra de construção da Mline em Top,Zero e 
Bottom. 
Scale - Define a largura da Mline. 
Style - Permite escolher o tipo de Mline dentro os criados pelo usuário. 
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42- SPLINE 

 Acesso – DRAW > Spline 

Conjunto de uma ou mais curvas concordantes definidas por uma seqüência de pontos, editadas pela tangente das 
curvas componentes ou pelos pontos externos. 
Acionado o comando Spline: 
Clicando em pontos seqencialmente, o Spline configurará para “curva ideal” em os pontos. 
Para finalizar o comando temos a clicar 03 <enter>. 
Formato: 
Command: _spline 
Specify first point or [Object]: P1 
Specify next point: P2 
Specify next point or [Close/Fit tolerance] <start tangent>: P3 
Specify next point or [Close/Fit tolerance] <start tangent>: P4 
Specify next point or [Close/Fit tolerance] <start 
tangent>:<enter> 
Specify start tangent: <enter> 
Specify end tangent: <enter> 

 
P2

P1 P4

P3

 

 43 -TEXT 
 Acesso – DRAW> Text 
Modo Simplificado:  T ou mt (via Teclado) 

Texto de modo Simples direto na tela gráfica. Texto pela caixa de multi-texto. 
- Single Text  (Draw<Text<Single Line Text) 
Podemos escrever também com o line single text, mas 
temos de  configurar da formatação de acordo que 
desejamos pela linha de comando. 
Acionando o Single text: 
Command: DTEXT 
Current text style:  "Standard"  Text height:  2.5000 
Specify start point of text or [Justify/Style]: 
Define um ponto 
Specify height <2.5000>:  
(especifique uma altura de texto) 
Specify rotation angle of text <0>: 
 (define ou não uma rotação para seu Texto) 
Enter text: (Escreva o seu texto agora) 
Enter text: (1 ENTER muda a linha – 2 ENTER finaliza). 

Command: _mtext Current text style:  "Standard"  Text 
height:  2.5 Specify first corner:  
(Clique um ponto e abra um retangulo) 
Specify opposite corner or [Height/Justify/Line 
spacing/Rotation/Style/Width]: 
 (Clique outro ponto e feche o retangulo). 
Agora pode digitar o seu Texto e editá-lo mais facilmente. 

 

 44 -ALIGN 
 Acesso – MODIFY> 3D Operation > Align 
Modo Simplificado:  AL (via Teclado) 

O comando Align apesar de sua concepção seja para o uso em 3D, e de muita utilidade também em duas dimensões.  
A partir de seu acionamento vamos indicando os pontos de referencia para uma suposta rotação e deslocamento, para 
uma nova localização e rotacionada da nossa peça , onde também  podemos alterar nessa mesma operação a Escala da 
peça em referência dos seus pontos.  
Formato: 
Command: Align 
Select objects: (Selecione o objeto  a ser 
movido) 
Specify first source point:P1 
Specify first destination point:P2 
Specify second source point:P3 
Specify second destination point:P4 
Specify third source point or 
<continue><ENTER> 
Scale objects based on aligment point 
<Y/N><N> 
 
Y- Sim para ecalonar em relação aos pontos 
clicados. 
N - Para manter a escala normal do desenho 
movido.  
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 45 -SCALE 
 Acesso – MODIFY> Scale 
Modo Simplificado:  SC (via Teclado) 

Acionado o comando Scale: 
1 - Selecionamos o objeto e confirmamos com um <enter>. 
2- Temos que definir um ponto, que servirá de referencia para o escalonamento. 
Na sequencia normal  ele pedirá o fator de ampliação (Acima de 1) ou fator de redução (Abaixo de 1), lembrando que o 
fator 1 e o tamanho original, se digitar 1 ou enter ele se manterá da mesma forma. 
   O Esquema com a opção Reference, segue os mesmos passos acima, até que quando pedir para o valor de escala, 
acionamos a opção REFERENCE, inserimos um valor de medida que você tem em seu  desenho, Ex. 25  - Agora ele 
pedirá um nova medida podemos Ex. 42. Feito a medida do desenho que tinha 25 unidades se torna com valor 42. 
NOTA:Essa opção  é muito útil quando recebemos  um desenho fora de escala (que é um erro grosseiro alterar a escala 
de um desenho, principalmente para imprimir)  e temos uma referencia de uma cota, para podermos voltar o desenho 
original. 
Formato: 
Command: Scale 
Select Objects:( selecione os 
objetos) 
Select Objects: <ENTER> 
Base point: P1 
<Scale 
ator>/Reference:(Entre com 
Valor da Escala) 

Formato com Referencia: 
Command: Scale 
Select Objects:( selecione os objetos) 
Select Objects: <ENTER> 
Base point:P1 
<Scale Fator>/Reference: R<ENTER> 
Reference lenght:<valor de referencia existente ou 
dois pontos>  
New lenght:(novo valor )  

 
46 - LAYER 

 Acesso – FORMAT> Layers 
Modo Simplificado:  LA (via Teclado) 

O comando LAYERS é um dos comandos mais interessantes existentes no autoCAD e em outros programas de CAD. 
Layers são níveis ou camadas, onde podemos fazer o seu gerenciamento que se comportam como se fossem páginas  
de papel transparente onde podemos ver  sua visualização na medida que necessitamos, Além disso, podemos definir as 
caracteristicas de entidades, que são cor e tipo de linha permitindo impor ao desenho o seu traço, pois cada Layer 
vamos associar, na plotagem, uma espessura diferente, utilizado para uma melhor criação, manipulação e de 
entendimento do desenho. 
LAYERS eo comando do quadro de diálogo que 
controla tipos ou informações de “ Camadas” para 
podemos ligarmos ou desligar, 
congelar,trancar,bloquear a impressão no momento 
que necessitamos determinados modos de 
apresentação do desenho. 
Layer Properties Manager para a criação de layers 
(camadas). Sepre que possivel dê preferencia, que  
todo o desenho deve-se ser feito em várias 
camadas. 
 Cada camada pode ser utilizada por um tipo de 
informação do desenho, como camada para 
estrutura, paredes, cotas,tipos e classificação de linhas, símbolos,mobiliário, portas, janelas, detalhes,etc. 

 

 
47 –BYLAYER / LINETYPE 

 Acesso – FORMAT> Linetype 
Modo Simplificado:  LT (via Teclado) 

As barras de acesso Bylayer estão normalmente na barra 
Properties, são de grande utilidade onde podemos configurar as 
e contornos com a cor, tipos de linha e espessuras. 
→  Selecionamos (com grips)  o nosso objeto ou a linha e 
cliclamos na primeira caixa (Bylayer)selecionamos uma cor para 
definir a nossa peça. 
→  Para carregar outros tipos de linhas,  caixa (Bylayer) do 
meio: 
1 - clique em OTHER e na Seqüência   
2 - Clique em LOAD para  caixa de linhas  e escolhas os tipos 
de linhas que deseja carregar. 
Podendo selecionar os tipos com ajuda CTRL para alternadas ou 
SHIFT para um grupo.  
 E para confirmar clique OK. 
Podemos mudar linhas já desenhadas, use os Grips e abra a 
caixa e escolha o novo tipo de linha. 
→  Podemos inserir espessuras, diretamente através da Terceira Caixa (Bylayer), mas só podemos visualizar as 
espessuras a partir da espessura 0.30,  lembrando que na hora de imprimir ou plotar a definição será exata. 
Para visualizar as espessuras setadas  bylayer ou LINEWEIGHT, você precisa acionar o botão LWT(line weight trace) e 
para imprimir setar no PLOT a opção lineweight para que essa opção seja válida.  
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 40 -GRIPS 
 Acesso – MODIFY> Stretch 
Modo Simplificado:  GR (via Teclado) 

Grips são aquelas marcas azuis (normalmente)que aparecem no desenho, 
quando você seleciona um objeto sem Ter ativado nenhum comando. A 
ferramenta GRIPS é uma espécie de edição de objetos.  
Através dos GRIPS podem ser ativados os comandos Stretch, Move, Copy, 
Scale, Mirror e Rotate teclando a barra de espaço após a “seleção quente”. 
A Seleção quente e quando selecionado por grips, clicamos um  dos 
quadradinhos, a princípio notamos que se mexermos com mouse ele apenas 
trabalhará com o Stretch, isto é, esticando a linha a partir daquele ponto. 
Quando teclamos a barra de espaço, ele alterará para os comandos acima 
citados em função do quadradinho selecionado. 
Detalhe se caso quiser esticar varias linhas ao mesmo tempo podemos 
selecionar com SHIFT pressionado e clicando outros pontos quentes, 
selecionado estes pontos, solte o SHIFT e clique e um dos pontos quentes  e 
arraste aletoriamente ou usando a projeção polar para uma medida exata. 

 

 

48 –PROPERTIES 
 Acesso – MODIFY > Properties 
Modo Simplificado CTRL+1 

49 –TOOL Palettes 
Acesso – TOOLS > Tool Palettes Windows 
Modo Simplificado CTRL+3 

 

Esta paleta de ferramenta 
permite que os objetos do 
AutoCAD 
sejam manipulados com 
grande facilidade, permitindo 
fazer 
mudanças diversas sobre as 
entidades 
selecionadas,como: cor, 
layer, thickness,elevation, 
posição 
Por exemplo, pode-se 
selecionar vários objetos 
com o grips e então filtrar 
para o objeto desejado. Se 
você selecionou vários 
objetos e deseja modificar 
apenas os textos, passe a 
seleção para Text e então no 
campo apropriado, escolha a 
alteração que deve ser 
executada.  
 

Este recurso permite criar 
novas paletas de 
ferramentas que pode ser 
adaptada pelo usuário. No 
Exemplo ao lado, visualiza 
uma biblioteca de símbolos 
que foi adicionada à paleta. 
Para criar a sua própria 
paleta dos símbolos, 
podemos copiar um bloco 
de cor ou hachura e definir 
as propriedades da forma 
que desejamos; outro 
modo para enserir um 
bloco é  abrir a paleta 
Design Center e arrastar os 
Símbolos desejados para a 

sua paleta. 

 

 
50 –Design Center  Acesso – TOOLS > Design Center 

Modo Simplificado CTRL+2 

Esta paleta de ferramenta permite um total 
controle dos desenhos existentes e o 
desenho que esta sendo editado, como 
pegar blocos, layers, textstyle, 
contido em um desenho que esta no disco 
rígido ou na internet e inseri-lo no desenho 
que esta   sendo editado. Ou copiar blocos, 
layer etc de outro desenho aberto. Pode 
utilizar esta ferramenta para localizar mais 
rapidamente os seus blocos a serem 
inseridos. Você pode também criar, por 
exemplo, um desenho que contenha todos 
os seus blocos de cozinha e deixar o 
Design Center explorar o arquivo para 
retirar os blocos desejados. 

 
 
 
 
 
 
 

PONTOS QUENTES
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 51 - DIMENSION 
 Acesso – Dimension>  
Modo Simplificado:  D (Style) (via Teclado) 

 
Uma das etapas mais importantes do processo de desenho  é a cota. O AutoCAD permite uma cotagem automática com 
amplas possibilidades de estilo e edição. Quando se faz uma cota, determinamos os pontos no qual queremos a medida. 
O AutoCAD guarda as coordenadas dos pontos marcados e faz o cálculo da distância entre dois pontos gerando assim a 
cota. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

DIM Linear - Cria cotas verticais (y) e horizontais (x), em quatro 
direções em relação aos pontos de origem. A partir de seu acionamento 
podemos clicar nos pontos com Osnap ou clicar <Enter> para  podemos 
selecionamos a linha que precisamos medir.

DIM Align   - Cria cotas 
alinhadas com direção foram da 
pelos pelos pontos de origem. E 
segue o mesmos passos da linear 

DIM Ordinate - Cria cotas 
a partir de pontos de 
coordenadas 

DIM Radius - Cria cotas através 
do Raio. Selecionamos os arcos 
e circulos.

DIM Diameter - cria cotas a 
através do Diâmetro. 
Selecionamos os Diametros. 

DIM Angular - Cria cotas de 
Ângulos. Como a criação de 
Fillet e Chamfer, clicamos as 
linhas que fazem seu vértice.

QuickDIM - Cria várias cotas 
automaticamente, com ajuda 
da cx. Flutuante cota várias 
dimensões ao mesmo tempo 
escolhendo o tipo de cotagem. 

DIM Baseline - Gera cotas 
sucessivas a partir de uma 
linha de base. 

DIMContinue - Gera 
cotas contínuas a partir de 
um segundo ponto da cota 
anterior.

DIMLeader - Cota livre 
para comentários e 
observações. Podemos 
acionar o Settings, para 
definiçãoe formatação de 
tipos  das leaders. 

Tolerance- Define tipos de 
tolerância em relação ao 
acabamento e qualidade de 
precisão da peça a ser 
trabalhada.

Dimension Edit -Faz 
edição das cotas já 
construídas.(rotacionadas 
e obliquas) 

Mark - Marca o centro de 
círculos e arcos 

Text Edit - Faz deslocamentos 
de linhas de Cotas e textos de 
cotas já prontas. Selecionamos a 
cota e com o mouse mostramos 
sua nova localização.

Update - Faz atualizações 
das Cotas para uma novo 
tipo de estilo de cotas, 
tamanhos, etc. Após a sua 
edição com o Style. 

Style - Define tipos das 
Cotas para uma novo tipo 
de estilo de cotas, 
tamanhos, fontes, etc.
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52 -ARRAY 
 Acesso – MODIFY> Array 
Modo Simplificado:  AR (via Teclado) 

 

Para criar uma matriz retangular: 
Acionamos o comando Array : 
1 – Por default – Abre a caixa  Rectangle 
Array: 
2 – A Direita  - Clicamos o botão Select 
Objects -  Para selecionar o objeto que 
iremos criar a nossa matriz. <Enter> 
para voltar para nossa caixa de dialogo. 
3 – Agora faremos a definição número de 
linhas (ROWS) e de colunas Colunas 
(COLLUMNS) , note que ao lado mostra 
como ficará nossa matriz. 
4 – Para finalizar temos que definir os 
dados, iremos preencher o campo Row 
offset que é a distância entre linhas e no 
campo Collumns offset  definimos o valor 
da distancia entre as colunas. 
Nota: Podemos adicionar uma inclinação 
a nossa matriz adicionando um valor de 
um angulo  ao campo Angle of Array. 
Observe que ao lado existem botões, um 
deles o maior, podemos definir a 
distância entre linhas e colunas atraves 
de uma diagonal de um retangulo 
imaginário.  
Os outros dois botões  correspondem 

respectivamente a definição manual das distancias entre linhas e entre 
colunas a partir de dois cliques. 

 
 
 
 
 
 
 
 
 
 
 
 

Agora vamos criar um Array Polar: 
Acionamos o comando Array.  
1 – Primeiramente selecionamos a opção 
Polar Array na caixa de dialogo, 
automaticamente veremos que a caixa de 
dialogo se altera de retangular para uma 
caixa array polar. 
2 – Clicamos no botão superior à direita  
- Select Objects -  Para selecionar o 
objeto que iremos criar a nossa matriz. 
<Enter> para voltar para nossa caixa de 
dialogo.  
3 - Clicamos na sequencia o botão Center 
Point  para definirmos o ponto central de 
nosso array polar, logo que selecionamos 
o nosso centro as medidas X e Y se 
alteram, correspondendo a nova 
referencia. 
4 - Definimos o numeros de itens que 
iremos copiar em volta do centro que 
clicamos acima. 
5 – Podemos manter o valor de 360 que 
corresponde a volta completa ou alterar 
para um ângulo de varredura diferente. 
NOTE: O metodo utilizado como default  
foi Total number of items & angle to fill. 
Mas podemos  definir com: 
-Total number of items & Angle between 
items – Esta opçãopermite definição do 
numero de objetos e o ângulo entre eles. 

Angle to fil & Angle between items – esta opção permite a definição do ângulo de varredura e o ângulo entre os objetos. 
 A opção já setada abaixo Rotate items as copied – da a condição  de rotacionar as copias dos objetos ou não  em 
função de seu ângulo de inclinação.  
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53 -BLOCKS  
Acesso – DRAW> Block > Make 
Modo Simplificado:  B (via Teclado) 

54 –INSERT 
Acesso – DRAW> Insert > Block 
Modo Simplificado:  I (via Teclado) 

Permite agrupar entidades individuais em um bloco na base de 
dados. Sempre que for necessário a inserção de desenhos 
repetitivos, ou dentro do proprio desenho ou criando um bloco 
atraves do comando WBLOCK para a criação de uma biblioteca. 

Comando Insert pode inserir um bloco construido dentro 
do desenho ou a partir de uma biblioteca, Lembrando 
para criar um bloco para biblioteca usaremos WBLOCK 

Acionamos o comando 
Block: 
1 – Abrirá a caixa de dialogo 
ao lado. 
2- De um nome para o seu 
bloco. 
3 – Clique o botão Select 
Objects e ele rotarnará para 
a tela gráfica para selecione 
o objeto que será o nosso  
Bloco. 
4- Clique o Botão Pick Point 
para definir o ponto ao qual 
servirá para a inserção do 
bloco por esse ponto. 
 
Esse formato se refere a um 
bloco em que voce utilizará, 

no desenho vigente. Para criação de um bloco que servirá para 
outros desenhos, temos que criar o bloco através do comando 
WBLOCK, ele segue quase da mesma forma que a criação do 
bloco comum, somente voce deverá indicar um local para salvar 
este bloco. 

Acionamos o comando Insert: 
1- Abrirá a caixa de dialogo abaixo. 
2- Se o nosso bloco foi feito recentemente, ele 

aparecerá na caixa Name ou então pode clicar 
na seta da caixa e procurar outros blocos. 

3- Caso seja um bloco de biblioteca – clique em 
browse e indique o local, onde esta o bloco 
procurado. 
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55-ATRIBUTOS 
 Acesso – DRAW> Insert > Define Attributes 
Modo Simplificado:  ATTDEF (via Teclado) 

O comando AATDEF ( atributos) permite criar atributos ou rotinas para desenhos e blocos. Um atributo é uma 
variável cujo o valor podem ser informado pelo usuário no momento da inserção ou edição. Um exemplo típico de 
aplicação são as legendas de desenhos técnicos. Cria atributos para cada campo de informação (títulos, autor, data, 
escala, cliente, etc.) os quais serão preenchidos via caixa de diálogo. 
Desenhamos o exercício no caderno de exercício nº 45 
Acionamos o comando Attributes: 
1 – Vamos Definir os dados da caixa de 
dialogo: 
TAG: Defina um nome de origem, esse 
nome aparecerá só na criação do bloco. 
Neste nosso caso vamos digitar como esta 
ao lado. 
PROMPT: Será a pergunta que será feita 
quando inserirmos o bloco. 
VALVUE: Este campo será o estará 
preenchido, quando inserirmos o bloco, 
seria default. 
Lembre- se que temos de definir também o 
tamanho de nosso texto, temos que 
corresponder ao tamanho de nosso bloco e 
ao nosso desenho, no momento configure 
como esta ao lado. 
2 – Confirmamos com Ok ou <ENTER> 
para retornar ao nosso desenho para 
definirmos um ponto que será o ponto de 
inserção do nosso atributo. Note que agora 
existe um texto (PREDIO) no local que 
clicamos. 
 
DICA: Um modo mais rápido para lista de 
atributos, de mesmo formato  é copiar as 
TAGs  já criadas e modificar como se fosse 
um Texto comum, ou sejá digite ED no 
teclado para editar novas TAGs. 
 

Agora vamos criar o nosso bloco: 
Acionamos o comando block e selecionamos a nossa mesa com o computador e os atributos. 
Agora podemos inserir o nosso bloco, com o comando Insert – depois de nos clicarmos o ponto de inserção, o Autocad 
vai listar as perguntas no prompt (linha de comando). 
 Mas para melhorar a configuração de  entrada de dados, podemos configurar o ATTDIA,  trocamos o valor de 0 para 1 , 
isto fará que as perguntas com as respectivas respostas Valvue, sejam mostradas em uma caixa de dialogo e não mais 
pelo prompt. 
Nota: No momento da inserção do bloco, as mensagens (perguntas) serão apresentadas na linha de comando (prompt) 
ou numa caixa de diálogo . Isso dependerá se estiver ativado a variável ATTDIA. Se o valor for igual a1, a caixa de 
diálogo será apresentada, caso contrário não. 
Execute a legenda abaixo: 

 
 56 -PAPERSPACE  Acesso – Tilemode (0) 

E o ambiente do Auto Cad onde: 
-Inserimos os formatos A4,A3, legendas, atributos, etc. 
Criamos janelas de visualização (exemplo: vistas com escalas e seções cortes) através do comando Mview. 
-Disparamos o Processo de Impressão. 

MODELSPACE / PAPERSPACE (LAYOUT) 
O AutoCAD permite a você trabalhar em dois espaços (ambientes) diferentes, 
a nossa area  de trabalho  (MODEL SPACE)(Model) e o espaço de trabalho 
para impressão no papel (PAPER SPACE)(Layout). 
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Todos os modelos bi ou tridimensionais são criados no MODEL SPACE, de certa forma infinitamente, isto é, desenhar 
sem se preocupar com os tamanhos ou escalas de acordo com a sua unidade de trabalho. 
 
Já o Paper Space e a nossa area delimitada para a nossa futura impressão, nós inserimos as informações do modelo 

criado, através de janelas individuais, estudando o  lay-out da folha 
(prancha) quanto a Escalas, vistas, anotações, detalhamentos, etc. 
Devemos sempre ter em mente que o ambiente PAPER SPACE é aquele 
usado para compor a folha de papel onde seu modelo será plotado 
(impresso). 
Cada pasta “ Layout1 e 2 e outras que podemos inserir, renomear,  
clicando com o botão direito do mouse sobre as pastas. 
A plotagem em PAPER SPACE é feita na escala 1:1, pois o padrão de 

margem e rotulo que você utiliza, será 
inserido em escala real. 
Comuta entre o PSPACE (layout)e o MSPACE(model), clicando nas suas respectivas pastas. Ao mudarmos para PAPER 
SPACE o icone que indica o UCS muda para o triângulo que indica o novo ambientede trabalho. 
 Inicialmente quando estamos em PAPER SPACE não temos acesso ao modelo criado no MODEL SPACE, isto é, E como 
tivessemos um vidro sobre o nosso desenho, onde podemos manipular e editar a janela e até desenhar sobre ela, mas 
não editar e completar o modelo.   
 Para que isto se reverta, no entanto, podemos clicar  o botão 
PAPER  ele automaticamente se altera para model, isto fará 
que “abrimos a janela” de cada janela do “Mview” criado dentro do paper space, e onde podemos criar as nossas vistas 
com escalas. E como veremos abaixo. 

 57 –MVIEW 
 Acesso – View > floating viewport ( mview ) 
Modo Simplificado:  MV (via Teclado) 

Permite criar janelas dentro do PAPER SPACE. 
O formato do comando é: 
Switching to paper space 
ON / OFF / Hideplot / Fit / 2 / 3 / 4 / Restore / < First Point > : 
First Point: Permite selecionar os cantos de uma única janela 
ON / OFF : Quando em OFF o AutoCAD limpa a janela em MODEL SPACE e não a regenera novamente até você torná-la ON 
Hideplot: Remove linhas escondidas quando o desenho for plotado em PAPER SPACE 
Fit: Cria uma janela do tamanho da tela gráfica 
2/3/4: Permite criar duas, três ou quatro janelas em uma única operação 
Restore: Esta opção forma uma configuração de janelas no PAPER SPACE que se ajusta a uma configuração 
gravada com VPORTS . 
ESCALA DENTRO DA JANELA 
Quando usamos a janelas no PAPER SPACE, a escala do desenho “trazido” do MODEL SPACE é de um valor 
indeterminado para o observador, para colocarmos um modelo dentro de uma janela do PAPER SPACE na escala que 
desejamos plotar usamos o comando ZOOM. 
 

 58 –ZOOM/XP 
 Acesso – VIEW > Zoom >  
Modo Simplificado:  Z (via Teclado) 

 

Permite definir a escala do desenho dentro das janelas no Paper Space após a sua criação. 
Após definirmos o tamanho REAL do formato do papel  (folha Padrão) Podemos variar a escala do desenho dentro das 
janelas previamente criadas. A partir do comando Zoom, utilizamos o XP para definir a escala. 
É o comando que permite acertar a escala de plotagem do modelo dentro de uma janela do PAPER SPACE. 
O formato do comando é: 
Zoom 
All/Center/Dynamic/Extends/Left/Previous/Vmax/Window/<Scale X / XP >: valor XP 
 
NOTA: Antes de trabalhar com zoom xp, temos que ter em mente o seguinte, o AutoCAD foi concebido para desenhos 
em mm ou polegadas. Quando criamos um desenho mecânico por exemplo, nós automaticamente trabalhamos com  
milímetros, então se queremos reduzir um desenho 5 vezes a escala é 1/5 , se for 2 vezes menor  a escala será ½  e se 
vamos ampliar 3 vezes a escala será 3/1, se for 10 vezes maior  10/1. Logo quando trabalhamos com o zoom XP a 
escala de redução será  ½ XP, 1/5 XP e a ampliação 3 XP e 10 XP. 
Agora quando temos que plotar um desenho de arquitetura por exemplo, que foi desenhado  em  1uma unidade se 
refere a 1 metro, sabemos  que 1 m = 1000 mm. 
Vamos adotar uma medida para tentarmos visualizar, utilizamos o desenho da planta do exercício 27. 
 Por exemplo vamos trabalhar com a medida de 7 metros. 

Clique na pasta Layout – Ele abrirá a Caixa de impressão – neste momento não precisamos configurar a 
impressora ou a plotter, pode fechar o quadro de dialogo. Automaticamente ele já enquadra o seu desenho na área 
delimitada.  
Clique no botão PAPER na Barra de Status e ele mudará para MODEL e abrirá a janela para nossa planta, como se segue 
abaixo: 
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Note que temos o eixo WCS – avisando que estamos 
dentro do Model . Agora  Acionamos o Comando Zoom e 
Digitamos 1XP 

Logo: 1/1000 =1XP é a escala real em nosso papel. 
Clicamos novamente o botão MODEL na Barra de Status 
para voltar para PAPER.  Se dimensionar ou conferir a 
medida com o Dist temos a nossa medida com 7 mm. 

Voltamos para o modo MODEL  e Acionamos o comando 
Zoom  e digitamos 2 XP. 

Temos Agora o nosso desenho na Escala 1:500. 

Utilizando o modo Model e Zoom novamente – digitamos 
4XP – Se pensarmos um pouquinho, 1000/4 é igual a 
250.  

Agora o nosso desenho na Escala 1:250. 

Podemos fazer isso sucessivamente. 
Se queremos a escala 1:100 – 10XP – a nossa medida terá 70 mm. 
Para a escala 1:50 – 20 XP – a nossa medida tera 140 mm. 
Note  que não  trabalhamos com um padrão nenhum, Utilizamos a area  default do AutoCAD, mas lembro que podemos 
inserir um bloco sendo um Padrão (A0, A1, A2,...) modelos com Legendas com atributos. 
 
 Para isso quando acionamos layout, podemos inserir o bloco com o padrão desejado, e dentro abrir janelas com Mview,  
para cada janela podemos criar um detalhe, uma vista, todos usado a Zoom para escala. 
Normalmente é um erro que muitos cometem em imprimir desenhos a partir do MODEL e para caber no seu padrão 
muda a escala original do desenho. Por isso que existe os layouts, para podemos dentro das janelas do Mview, mudar as 
escalas. 
PLOTAGEM A plotagem de um desenho em PAPER SPACE é feita na escala 1:1, sendo a forma mais adequada de 
montagem de pranchas a serem plotadas em birôs. Quando mandar imprimir você apenas indicara que é uma plotagem 
1:1 ou dizer em qual tamanho ou padrão quer que imprima.  
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Lembramos também se não definirmos a tabela de valores das penas referentes ao seu desenho, os valores para sua 
impressão de espessuras todo desenho por default  será de linhas 0.25 e cores vigentes. 
 

 
 60 -PLOT 

 Acesso – FILE> Plot 
Modo Simplificado:  PLOT(via Teclado) 

A plotagem é o processo de passagem do desenho do computador para o papel e, normalmente, deixa muitas dúvidas 
nos usuários de AutoCAD.  
1-na Pasta Plot Device -  Definimos a impressora ou plotter . 
2- Clicamos no botão New – para definirmos um estilo para um conjunto de espessuras. 
2a – Selecione a opção Start From Scraftch - <avançar> 
2b – De um nome ao novo estilo e  avance para concluir.  

 
3– Agora observe que a opção Edit foi ativada – clique para definirmos as espessuras de linhas. 
3a– Selecione uma cor no quadro (ex. Color 1 –red) note que a direita  a opção color esta: use object color  -  

se você quer que toda linha vermelha no desenho  imprima em preto – clique na caixa e selecione a opção black. 
3b -  Se desejamos uma espessura especifica para nossa linha color 1– clique em  LineWeight e defina uma opção de 
espessura. 
4 –Agora podemos definir as outras cores, se possível sempre trabalhe com as cores padrões 1 a  8 para que se torne 
fácil para sua configuração quando for imprimir.   

 

 
 

 

Na pasta Plot Settings – onde podemos definir o 
tamanho de folha de impressão.  
1- Clicamos no botão Window para o 
enquadramento da área que iremos imprimir. 
2  - Notamos que ele  nos envia  para a área do 
desenho e espera que definirmos dois pontos de 
uma  janela da área que desejamos imprimir.  
3 – A partir do retorno a nossa tela  - clique no 
botão Full Preview que ele irá mostrar uma previsão 
da nossa impressão. (depois de carregado o preview 
– clique com o botão direito do mouse na previsão e 
clique exit para voltar a tela anterior ou plot para 
imprimir). 
4 – A opção default Scale to Fit ira imprimir o 
enquadramento maior possível dentro da área do 
papel. Ou então defina uma escala para tal. 
5-  A opção plot offset ira centralizar a nossa 
seleção no centro do papel. 
6 – Lembro que as opções Extents – será para 
impressão de toda extensão do nosso desenho, a 
opção Display  é para o desenho que temos em tela 
e a opção limits será por definição os limites 
determinados do desenho.  

 

Continua na apostila 3D- 


